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OVERVIEW

'Grounded' is an introductory course to Geographical Information System (GIS) software (digital mapping
software), designed for secondary school students. The course is aimed at Transition Year students and has
been produced to fulfil all the requirements of a Transition Unit.

The overall objective of this course is to teach students how to make their own maps, learning how it can be a
strong support to decision-making processes for territorial and environmental plans. There is also a focus on
global and local citizenship, using mapping to explore social and environmental issues that are affecting their
locality — regarding conservation, sustainability, accessibility and mental health. Throughout the course the
students will be reminded to consider the United Nations Sustainable Development Goals.

Most people use a GIS in some form without even realising it e.g. GPS on a phone providing directions. It
makes sense that secondary school students become educated in this now integral part of our lifestyle.
Learning QGIS will give them the skills to actively contribute to a more informed world.

This course aims to help students prepare for 'adult and working life' by giving them greater responsibility for
their own learning. The GIS skills will also benefit them for application in a huge array of careers:
environmental management, retail, military, tourism, meteorology, geography, etc.

Commercial/proprietary GIS software (software that cannot be freely shared or modified) is usually very
expensive and entails limits on the freedom to copy, share and modify the software. QGIS is a high-quality
free software. Learners can use this software anytime and anywhere, for personal projects, to solve
professional problems, for research applications, etc.

Exciting possibilities are created when principles of free sharing of knowledge are embraced; a more
collaborative world which seeks communication and progression. We hope the student enjoys learning and
using QGIS and embraces a future of generosity in all forms with the pursuit of knowledge and understanding
at its core.
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FORWARD FOR THE STUDENT

REQUIREMENTS FOR THE COURSE

Before deciding to teach this course please do a check to ensure that you will have access to the following:

e QGlIS software (free download, see Appendix E)

e Use of the same computer/laptop for each class or use of a personal USB
e Internet connection

e  Excel

If you are going to access the video tutorials, it is recommended that you wear a headset in order to hear the
videos better. There are five lessons. Each lesson is suited for completion over the course of a teaching week
(two double class periods or one double and one single class). However, you may save and return to your work
at any stage. The remaining 5 weeks are for completion of a Group Project.

FORWARD

The Course aims to guide students to self-teach themselves how to use QGIS.
No prior knowledge or experience in QGIS is required to complete this course.

The lessons are taught using step-by-step Exercises (screenshot-based). The lessons should be taught in
sequence as each exercise is built on the foundation of the previous classes. Each Lesson has a video tutorial
(approx. 25 mins) to aid students who learn better via audio-visual means. This also encourages independent
learning.

Take the opportunity of Transition Year to broaden your experience. This course is a fun and easy way to learn
a valuable skill which you can use professionally and personally.

“Teachers can open the door, but you must enter it yourself.”

— Chinese proverb
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INCLUSIVITY STATEMENT

Diversity, equity, and inclusion is critical to creating great education content. It is our intent that students
from all backgrounds and perspectives be well-served by this course; that students' learning needs be
addressed, and that the diversity that the students bring to this class is viewed as a resource, strength and
benefit.

This course was designed with consideration of the Universal Design for Learning (UDL) guidelines (see figure
below). Our aim was to serve varied learning preferences. The course content has a balanced text-to-visual
ratio. As well as aiding the learning experience overall, this also help students who may be stronger at learning
in either format and would be at a disadvantage should they not be represented. There are also video tutorials
demonstrating the exercises. Students who prefer to read textbooks may choose to follow the manual,
whereas more visually-orientated students may opt to follow the video style. It is likely that most students
would benefit from a mixture of the two. Some students may benefit from a chance to focus on content alone
as opposed to learning along with a teacher and class. The course has therefore also been created to allow
'self-teaching'.

The form of assessment is also provided as a choice so that the student may produce a poster (can be text or
image heavy) or create a video. This should allow students to be assessed in a way that they can show what
they know and have learned in the way that best demonstrates their ability.

Everybody deserves to learn and to have the chance to learn and be assessed in a way that suits their
strengths.

AFFECTIVE NETWORKS: RECOGNITION NETWORKS: STRATEGIC NETWORKS:
THE WHY OF LEARNING THE WHAT OF LEARNING THE HOW OF LEARNING

-\
»‘a

Engagement Representation Action & Expression
For purposeful, motivated learners, For resourceful, knowledgeable For strategic, goal-directed learners,
stimulate interest and motivation for learners, present information and differentiate the ways that students
learning. content in different ways. can express what they know.

Figure 1: Universal Design for Learning Guidelines (source: https://www.cast.org/impact/universal-design-for-
learning-udl).

"Education is the most powerful weapon you can use to change the world.”

— BB King
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1. CLASSROOM QGIS COURSE

INTRODUCTION

Welcome to Grounded — Explore your world, a course where you learn how to use QGIS to make your own
maps and investigate the world around you. QGIS is a fun, easy to use software. This course involves a series of
exercises with real life scenarios. The exercises are also available via YouTube video tutorials (approx. 25 min),
accessible here: https://cutt.ly/9jUZ7bE.

Keep track of your progress throughout the course using the Goals Sheet found in Appendix A. If you need to
install the QGIS software then please refer to Appendix E.

SUSTAINABLE DEVELOPMENT GOALS

You are going to learn how to map through the perspective of global and local citizenship. With each exercise
we will consider the United Nations 2030 Agenda Sustainable Development Goals. These are a call for action
by all countries in a global partnership to transform our world, listed as follows:

1: No Poverty 10: Reduced Inequality

2: Zero Hunger 11: Sustainable Cities & Communities

3: Good Health and Well-being 12: Responsible Consumption & Production
4: Quality Education 13: Climate Action

5: Gender Equality 14: Life Below Water

6: Clean Water & Sanitation 15: Life on Land

7: Affordable & Clean Energy 16: Peace & Justice Strong Institutions

8: Decent Work & Economic Growth 17: Partnerships to achieve the Goals

9: Industry, Innovation & Infrastructure

RESOURCES

https://worldslargestlesson.globalgoals.org/;

https://www.un.org/development/desa/disabilities/envision2030.html

1] GOOD HEALTH QUALITY GENDER GLEAN WATER
POVERTY ANDWELL-BEING EDUCATION EQUALITY AND SANITATION

fbiel

DECENT WORK AND 9 INDUSTRY, INNOVATION REDUCED " SUSTAINABLE CITIES 12 RESPONSIBLE 1 CLIMATE 1 LIFE BELOW
ECONOMIC GROWTH AND INFRASTRUCTURE INEQUALITIES AND COMMUNITIES CONSUMPTION ACTION WATER
AND PRODUCTION

15 LIFE 1 PEACE, JUSTIGE 1 PARTNERSHIPS

ONLAND ANDSTRONG

INSTITUTIONS

FOR THE GOALS

)
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LESSON 1: INTRO TO MAPS AND QGIS

LEARNING OUTCOMES:

e Types and utility of maps

e Elements of a map

e Effect of commuting

e Understanding the importance of data management

BACKGROUND

Maps can be very useful for numerous applications in your life. For example, they can help you show

distances, explain what is happening in your locality, orientate people, explore areas and discover new places.

During the Covid-19 pandemic organisations such as the World Health Organisation and governments
worldwide used GIS to monitor the outbreak. When was the last time you used a map?

There are many types of maps. They can be used for navigation, establishing ownership, and presenting
information.

e Political maps are made to show governmental boundaries of nations, states, counties, cities and

towns.
e Cadastral maps are used to show ownership of individual properties. Cadastral mapping is one

of the

oldest forms of mapping, with ancient Egyptians developing cadastral records to establish ownership

of land after flooding of the River Nile.

e A Physical map is a description of the geographical features of a location, their main function is to

indicate landforms like deserts, mountains, lakes and plains.

e ATopographic map is a lot like a physical map because it indicates different physical landscape

features. Topographic maps are different because they use contour lines rather than colours to show

changes in the land elevation instead of land type.

e Thematic maps are designed to highlight information on specific topics. It could be anything from

geology to population density or weather.
e Navigational maps are designed specifically for direction and are often referred to as charts.

e General Reference maps are also ideal for helping you to get to your destination, but they tend to be

easy to read, and include street and tourist maps.

RESOURCES

Video about the importance of maps:

https://www.esri.com/videos/watch?channelid=UCJ203R9PsZn6wF zYfsp1SA&videoid=mR2CWUOSC08&playl

istid=PL1U1yOIVhnz-36tcNI eSRZ0c80 -7G6B&title=the-importance-of-maps
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Figure 2: Thematic map showing percentage of obese adults per country (source:
https://www.dailymail.co.uk/health/article-2920219/How-fat-country-nations-highest-obesity-rates-new-
maps-surprise-you.html)
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Figure 3: Tourist map of Trim (source: https://townmaps.ie/trim-town-map/)
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HAND DRAWN MAPS ACTIVITY

Before we start making maps digitally we need to think about how to do it without a computer. In this activity
you will sketch a rough map showing your commute to school.

Objective:

e Understanding what constitutes a map and why we use maps.
e Considering the effect choice of transport has regarding commuting to school.

Task: Map your Commute to School

Your relation has asked what your commute to school is like. You are going to draw them a quick, rough map
to help describe to them the journey you take every morning and answer the following questions:

e  Could the community be designed to be more sustainable as regards students commuting?

e How could your school encourage reducing fossil fuel consumption?

Your map can be as detailed or as basic as you wish, creative or simplistic.

Main Sheeet Fn_l

STRELTS "
Yhuew OF R MESS

BT )
THING (NTERESTING

Figure 4: Examples of hand-drawn maps (source: left - https://www.readworks.org/article/Make-a-Map, right -
https://br.pinterest.com/pin/158751955596135613/?nic_v2=1a6eRv3tb)

Relevant Sustainable Development Goals:

GOOD HEALTH 11 SUSTAINABLE CITIES 12 RESPONSIBLE
AND WELL-BEING AND COMMUNITIES CONSUMPTION
AND PRODUGTION

)
Grounded - Explore your world 4 Science Sﬁ

Foundation
reland For what's next


https://www.readworks.org/article/Make-a-Map
https://br.pinterest.com/pin/158751955596135613/?nic_v2=1a6eRv3tb

UscrooL
Steps:

Before you begin to draw take a second to consider, what do you think would be useful to include in this map?
The information included on any map depends on what the map is used for.

1. Include the basics: draw the important features which are required to display the information — Your
house and the road (or roads) to your school. Are you going to draw these features as cartoons, or
will you just indicate them by doing something like an 'x' or a circle? It's up to you. Is your map
obvious or should you include labels to help the reader?

2. Elaborate on this basic picture:

e The map could be showing a commute of 100km or 1 km, we need to indicate scale to help
the map reader. Include a bar/line/arrow on your map indicating the approximate distance
or length or time it takes to travel between two points.

e Would someone know they were on the right track if they went by your map's information?
To help them you should include some key navigational features e.g. buildings like a shop,
pub or church, road signs, noticeable features like statues or murals, or even a very
distinctive natural feature such as a tree or large rock.

e s it clear from your map whether you live in a rural or urban setting? (Hint — you could draw
numerous buildings for an urban environment or grass/trees for a rural environment).

Note: You don't have to include a north arrow as it might be difficult to include orientation into this type of
representation. Not all maps are produced for direction, many are used for visualisation purposes.

There's no right or wrong way to do this mapping activity, you can be as simplistic or as creative as you feel
like. The map doesn't have to be highly detailed or polished.

When you're finished compare your map to others in the class. Add in any ideas that others had which you like
the look of. Maps are constantly being improved by using other people's ideas.

Now, discuss the commute to school with the class and answer the Task questions.

O
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EXERCISE 1A: INTRO TO QGIS

Now that you have thought about what is involved in creating a map, we will quickly move on to learn how to
make one digitally! This is where QGIS comes in. First of all we need to do some preparation by setting up the
folder structure, then we can open the program. Organisation is key to a smooth QGIS experience.

Objective:

e Organising the folder structure for creating and saving QGIS data.
e  Opening QGIS and exploring the workspace.

Task: Folder Organisation and Opening the QGIS Program

In the steps below you will set up your folder structure for saving your QGIS projects and data. Then you will
open the program and explore the workspace.

Note: If you cannot use the same computer/laptop for every QGIS class, then you will need to save everything
on to a personal USB and work from the device each time. It is important that you save all your QGIS work in
the one place.
Exercise 1A Steps:

Data management

1. Create a folder on your USB or desktop called QGIS - 'Student Initials' (e.g. as I'm called Fiona
Stapleton the folder is called QGIS-FS). All files associated with the course will be saved in this folder.

2. Within your QGIS folder, create a subfolder called 'Workspaces' and another called 'Shapefiles'. Your
file structure should now look similar to this:

| M + | QGIS-FS
Home Share View

« v 1 » This PC » |Desktop > QGIS-FS »
Name Date modified Type Size
7 Quick access
B Desktop Shapefiles 15/06/2020 14.28 File folder
Workspaces 15/06/2020 12:21 File folder
¥ Downloads

=| Documents

=| Pictures

°
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3. Open the QGIS program

UscrooL

. It will be under Q in the Start Menu:

OSGeodW

Outlook

Paint 3D
People
Photos
PowerPoint

Publisher

Settings

Simple Solitaire
Skype

Skype for Business
Snip & Sketch
Spotify

Ctirl Nntec

je btaz’( asearch

Productivity

(-

Microsoft Edge
Explore

Cloudy

a 2 v

Microsoft Store Dublin

4}

Solitaire

$

HP JumpStarts

QGLS workspace intro

Have a look around the QGIS Program, it should show something similar to the following figure. This window
is called the '"Workspace'. The various areas in the Workspace are explained below but it's not necessary for

you to remember - you can always refer back to the figure should you need to.

Favorites

» " spatial Bockmarks
» (@) Home
=

@ GecPackage

7 spatitite

@ rosiGis

P mssal

@ Oracle

Layers @®|
vasvi-gan o

@ untitled Project - QGIS o - a x
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
TmEREEE Q%P LR AHEBEDR "Ri-a-% %}ZE'AT~P
BV AWE 5= Qae - B
eeR
BEoSna ° “*| Project Templates

New Empty Project

EPSG:4226 - WGS 84

qars gis.09 to get. rsion 3.10.10
Coordinate

W sale 37a7ess ~ | @ Mogner| 100%

3| Ratstion (00 |3| ¥ Render @ scuns @
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Menu Bar - Provides access to all functions and plugins.

Toolbar - Provides access to more common functions.

Browser Panel - Lets you navigate in your database.

off in the Map View by clicking the box beside the name.

Layer List - Shows data layers you added to the workspace. Layers can be turned on and

Map View - Where the map itself is displayed and where layers are loaded.

Status Bar - Provides information about the project settings (map scale and coordinates).

4. Within the workspace click in the status bar Coordinate box and type 'world":

| Coordinate|  world| ||% Scale 135885344 ¥ | [ Magnifier| 100% % | Rotation | 0.0 ° $| V| Render @ epsciazze @
The World Map is added to your layers panel and it loads in your map view:
(G “Untitled Project - QGIS — = F

] BEE e
LAY A N
ee R
Browser (2)
leT®Reo

Favorites
v " Spatial Bookmarks
b (&) Home
v O
& GeoPackage
# Spatialite
W rosiGis
P mssaL
@ Oracle

Layers
v A %Y H-2A0

Project Edit View layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

D pleHPS 2 LMY e o0 = R

= gy g @

1legend entries removed. Coordinate| 37.7.-111.1) | Scale 135885344 ¥ | @ Magnifier 100%

< Rolation [0.0°

$/ |V Render @ epscazs @

Just like Google Maps the map in your Map View can be dragged and zoomed in and out. Have a try, zoom in

to Ireland, use your mouse scroll wheel or the zoom icons, U

P Y
(==
_—y
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5. There are some commonly used tools that are handy to have displayed in our Workspace. Right-click
on some empty space in the toolbar area and tick on the 'manage layers toolbar":

Panels
Advanced Digitizing Panel
v Browser (2) Panel
Browser Panel
GPS Information Panel
Layer Order Panel
Layer Styling Panel
v Layers Panel
Log Messages Panel
Overview Panel
Processing Toolbox Panel
Results Viewer Panel
Spatial Bookmark Manager Panel
Statistics Panel
Tile Scale Panel
Undo/Redo Panel
Toolbars
Advanced Digitizing Toolbar
v Attributes Toolbar
v Data Source Manager Toolbar
Database Toalbar
v Digitizing Toolbar
v Help Toolbar
s/ | abel Toolbar

Manage Layers Toolbar
/" Map Navigation Toolbar
V| Plugins Toolbar

v Project Toolbar

Raster Toolbar
Shape Digitizing Toolbar
Snapping Toolbar

V' Vector Toolbar

& Mag V. Web Toolbar -

A toolbar is added to the layout (left of the panels in the image below). Now your workspace is set up to show
most commonly used features in QGIS:

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
D@ QLo RP LB LEDOR B #Tm- O
B@GViLsw @ = ®R 2
Browser (2) [=]E)
Vo [nerae
'é Favorites =
ﬁ] » [¥ Project Home
5 b “SpatialEookmarks
,D v [&] Home
r [7CA
ﬁ’ GeoPackage
f Spatialite
@ rostGis
P mssaL
@ Oracle b’
% Layers. (]3]
d}‘av o 0 & T P 3=
Ve

We don't need to explore the different features of QGIS any further for now, we will instead begin to use QGIS
to make maps straightaway in the next Exercise!

Science
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EXERCISE 1B: YOUR FIRST QGIS MAP

You are now ready to create your first map using QGIS.

Note: Don't get wound up trying to remember steps or how to do things in QGIS, you can always refer back to
this manual or watch the video tutorials (accessible here: https://cutt.ly/9jUZ7bE). You will get better at QGIS
through repetition and with time.

Objective:
e Producing a digital map using QGIS.
Task: Showing your School Location

A craft is an activity involving skill in making things by hand. Your local town has launched a 'Craft Initiative' to
encourage a more sustainable way of living e.g. producing local knits instead of selling imported clothing,
creating wooden Christmas decorations instead of plastic versions.

In order to showcase local goods and encourage uptake of crafts, there is to be a craft fair held in your school.
You've been asked by the Craft Fair Committee to make a map showing your school location in relation to
surrounding roads. This map will be included in emails, posters, and the school's Facebook, to advertise the
event and to help people find the fair.

Relevant Sustainable Development Goals:

SIJSTAINABLE CITIES 1 2 RESPONSIBLE
AND COMMUNITIES CONSUMPTION
AND PRODUCTION

jn
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Exercise 1B Steps:

1. Open QGIS
Save the Workspace as 'School-Location': Project > Save As (remember to save in the folder
Workspaces). Keep the file type as qgz.

(- Untitled Project - QGIS
Edit View Layer Settings Plugins Vector Raster Web Mesh Processing Help

—ew Ctrl+N B QoR LD _ _

New from Template »

<abypl <abe] 7
| Open.. Ctrl+0 = : .
Open From » News
Open Recent 4
Close QGIS 3.10 Changelog no|
E Save Ctrl+5 Do you want to see all the amazing
provide a nice, centralized list of al
Save As... Ctrl+5Shift+5
Save [0 ’
Revert...
Properties... Ctrl+5Shift+P
Snapping Options...
Import/Export 4 A message from Marco B|
|§ E?l New Print Layout... Ctrl+P ¢ Dear QGIS community, we recenth
= A honoured and excited to have beg|
&) New Report. Y0 ’ heights. To find out more about th
*-._
[ Layout Manager... \
Layouts »
Exit AGI5 cri+Q Project Templates
* GeoNode
Layers 2l New Empty Project
0l & T 5 -3 FDQ
WGS 84
O
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G Untitled Project - QGIS
() save Project As X
T+ > ThisPC >| Desktop > QGIS-FS > Workspaces > ~ O Search Workspaces p b
Organise ~ New folder B= - -
' This BC ~ Name - Date modified Type Size E
¥ 3D Objects Shapefiles 13/06/2020 14:01 File folder
[ Desktop [this mey
Documents v
¥ Downloads
J‘ Music
[=] Pictures
E Videos
£ Windows (C)
4 Jeir favoy]
¥ Network v happy Y
message]
File name| | School-Location -
Save as type| QGZ files (*.qgz) @
~ Hide Folders Cancel §
reayer
o @l & 7 &~ O New Empty Project
WGS 84
3. We are now going to add base mapping and zoom in to your school (we do this through a feature

called a Plugin): Use of a Plug-In

Click Plugins on the menu toolbar > Manage and Install Plugins

(2 School_Design - QGIS
Project Edit View Layer Settings JHBBIGE Vector Raster Web Mesh Processing Help
D _ ﬁ ='.=: {’_"} ! &+ Manage and Install Plugins... ﬁ
Ve . Python Console Ctrl+Alt+P
®QV.Am @ | ,
O- ﬁ c,‘ f h ‘“‘ T e QMetaTiles 3
Browser & ® il
Q&THO
';‘j'».‘ " Favorites =
» IV Spatial Bookmarks
» [ Home
y Gy
» @ GeoPackage
ﬁ’ Spatialite
@ rostGis
P mssaL
@ Oracle
DB2
U
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Search for QuickMapServices > Install

U sEhool

X

@ Plugins | Al (573)

& A

==,
7] Installed

% MapTiler

# QuickMapServices

2% Not installed

¥ Install from ZIP|

# Settings

FE

QuickMapServices @ °

Collection of easy to add basemaps

Convenient list of services + search for finding datasets an|
basemaps. Please contribute new services via
http://qms.nextgis.com! Built by NextGIS

7777 831 rating vote(s), 1941346 downloads

wfs, wms, openstreetmap, osm,

Tags
service, tms, geojson, internet, qms,
basemap

Moreinfo homepage bug tracker code
repository
Author  NextGIS

Available version 0.19.11.1

>

4
Upgrade All Instoll Plugin |,

# Zm-e D~

Help |Install, reinstall or upgrade the selected plugin
T

Close

The Quick Map Services globe icon now appears in the vector toolbar,

—

{‘;

-

sd

:Zﬁ

Web Mesh Processing Help

I &IV 2

A
Click on the Quick Map Services Icon, o, choose OSM > select OSM Standard

9 Genshtab »
#%> Ukraine Cadastre 4

& Waze 4

OSM Cycle ma
9 Yandex 4 @ v P
~# OSM Humanitarian
n Bergfex 4
, P8 osM Standard

H ehtlas Mos
P8 osm 3 @ OSM TF Landscape
@ - (B 0SM TF Outdaors
<4 Search QMS Panel

@ OSM TF Transport Dark

) Add to Search
B 0 Seard (B NSM Trancnnrtatinn

Zoom in to your school location using the zoom icons, J J , or the scroll wheel on your mouse (example

shown below is Crana College, Co. Donegal):

P

3 N\
N i
£ St /§/ N\
£ Ol [ &/ R
& bas 4 [ R
= Yeny, | N
k5 Py A N
& L NN
& R238
N
A N
N K
: NN
\x\
AN
W
S
\ o\ o
\ =
o 2 \
\ \ = L
\ \ -
\ -
NV ' s
R238 -
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Now we are going to highlight your school location with a symbol on the map. On the Menu
Toolbar select: .

Create a shapefile
Layer > Create Layer > New Shapefile Layer

(2 *MyFirstMap - QGIS
Project Edit View JEEd Settings Plugins Vector Raster Web Mesh Processing Help
D I [EE (!Qata Source Manager Ctrl+L [m ['j [m E |:|L1 %é}
Create Layer » @j MNew GeoPackage Layer... Ctrl+5Shift+N
Add Layer » . New Shapefile Layer...
ﬂ Bg)vts‘erv T ¢ Embed Layers and Groups... ,ﬂ New Spatialite Layer...
=~ a
T - Add from Layer Definition File... @ New Temporary Scratch Layer...
% 5.0 Favorites
v_, L Spatial B Copy Style m New Virtual Layer...
/;' b [& Home Paste Style
o r oo Copy Lay
y Layer
r &7 GeoPack
A A

Save it in the Shapefiles Folder, with the file name 'School'. Keep as type ESRI shapefile.

Q Save Layer As

« ~ 1 > ThisPC > Desktop > |QGIS-FS > Workspaces > Shapefiles ~ U | Search Shapefiles y)

Crganise New folder B .
My Course ~  Name Date modified Type Size

Fowerpoint [1 school-Areashp 11/06/2020 1%:18 SHP File 1KB

@ OneDrive

Attachments
[ Desktop

Documents

| Pictures
= This PC

~# 3D Objects
[ Desktop v

File name: | School

Save as type:| ESRI Shapefile (*shp *SHP)

~ Hide Folders

Save Cancel

Make sure Geometry type says 'Point'. Leave all other options as they are and press 'Ok'.

E} New Shapefile Layer b4
File name C:'\Wsarshfiona\OneDrive\Desktop\QGIS-FS \Workspaces\Shapefiles! School.shp L =
File encoding UTF-5 Tt -
Geometry type 5 Point I_ {% -
Additional dimersions * Mone Z (+ M values) M waluses
EFSG:4326 - WGS B4 - ||
Grounded - Explore your world 14 ’
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QGIS
UscrooL

The School shapefile now appears in the Layers panel as a layer.

@ *MyFirstMap - QGIS

DEEREY OPLLRPP

Browser @®

®oerae
‘% _:.: Favorites
ok Y Spatial Bookmarks

“1 b [& Home
Ay Da

'ﬁ » @GemPa[kage

/ﬁ Spatialite

4] @ rostGis

P MssaL

@ WMs/WMTS
@ XYZ Tiles
" OpenstreetMap
@ wcs
A7) WFS
©) ows
@ ArcGisMapServer
@& ArcGisFeatureServer

Ll

* GeoNode
Layers B®
¢ A %T&-HAOL

School |

~ W = OSM Standard

Project Edit VWiew Layer Settings Plugins Vector Raster Web Mesh Processing Help

A LRSS &

&
£

i

sy BP0 O

el

e,

ROCHela Tarrace

g0 752

=
s
e

B-E-REE#E=-0 M-
4 =% %= QO

This School layer is currently empty. We edit it to place a point on the map where the school is located. Right-
click on the layer within the Layers Panel and select 'Toggle Editing'.

@ Oracle ! Duplicate Layer
@ DB2 _$ Remove Layer...
& WMS/WMTS —
- @ XV7 Tiles = QOpen Attribute Table
=" OpenStreetM
& wes Eilter

&7 WFsS
) OWS
@ ArcGisMapServer
& ArcGisFeatureSer
* GeoNode

Layers

« [ ® T &~ &
School

* /| =" OSM Standard

Change Data Source...

Set Layer Scale Visibility...

Set CRS >
Export 4
Styles 4
Properties...

At first it appears that nothing happened, but a yellow pencil has appeared beside the School shapefile in the

Layers Panel, and the editing icon, j , in the toolbar has become shaded in —these are highlighting that the

layer is now in edit mode.
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15

U
Y d
Science S I
Foundation

Ireland For what's next



UscrooL

() =MyFirstMap - QGIS
Project Edit View Layer 3Settings Plugins Vect% Raster Web M

DB RRY Ve, RPP
[ 4V S Y

Browser £3]

LET*O

@ Favorites
v y [P Spatial Bookmarks
1 [a4) Home
F AL
'ﬁ L4 @ GeoPackage
ﬁ’ Spatialite
A @ rostais
P Mmssal
@ Oracle
2 ps2
€ WMS/WMTS
€® XYZ Tiles
=* OpenStreetMap
&) wWcs
) WFS
) OWS
@ ArcGisMapServer
Qy’ﬁ' ArcGisFeatureServer
* GeoNode

Layers B B
o [ ® T (2 B

V| & School
* /| 3= OSM Standard

4

Other icons that were grayed-out are now also 'clickable'. We will add a point to the map using the 'Add Point

o e

Feature',® £J, which has now become clickable.

(2 *MyFirstMap - QGIS
Project Edit View Layer Settings Plugins Vector Raster Web

nEEREE O S S BPP
’vf[&“ °°_°F"{" e |

Browser Add Point Feature 2@®
L & T 1(Ctrd+)
Fa\.-forltes

& b "SpatialBookmarks

The cursor changes to a crosshair. Click on your school on the map and a dialog box opens. Change the id to '1'

and press Ok.
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School - Feature Attributes

4

E 7

5 e

= 5

. e
Actions e

3 (1]
id o |

o

0K Cancel

The crosshair has left behind a point feature where we clicked on the map (highlighted by red box in the figure

below). The yellow pencil has also changed to orange in the layers panel, this is showing that we have made
unsaved edits. It's important to save your edits

[ D82 3
@ WMS/WMTS
v & XYZ Tiles
=" OpenStreetMap

@ wcs

7 wrs

© ows

& ArcGisMapServer

&) ArcGisFeatureServer

* GeoNode
Layers

o 3w T |2 3= Y

V| # School
v = OSM Standard

i w09 07

Save the layer edits by clicking on the Save Layer Edits icon, m There is a small orange pencil
showing us that there are current unsaved edits. Once saved the orange pencil in the layers panel

changes back to yellow. This is telling us that the edits are saved but the layer is still in edit mode.

(=) *MyFirstMap - QGIS

Project Edit View Layer Settings Plugins Vector Rast

DEBARREE O@pPpPHED

E o

{:,.
&=

Now we will add a label to our point feature. We keep the layer in edit mode to do this. Right-

click on the School shapefile in the Layers Panel and click Attribute Table (notice the yellow
pencil is still shaded in, indicating that we're still in edit mode):

Add a label
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(2 *MyFirstMap - QGIS
Project

OB B E

Edit View Layer

Settings Plugins Vector Raster Web

OepplPP.

X Vo

[ V4
Ha

A/ &=
Browser
®|oucvrre
@; <7 Favorites
» 7 Spatial Boo
m » [6] Home
L ADESEe)
ﬁ b @GeoPackagE
ﬁ' Spatialite
2 W rostals
P mssaL
@ Oracle

4

& XYZ Tiles

D Zoom to Layer
Zoom to Selection
H Show in Overview
Show Feature Count
Copy Layer
Rename Layer

E Duplicate Layer

[l Remove Layer...
B Open Attribute Tz
'/ | Toggle Editing

=" OpenStr
& Wes
45 WFs
€ ows
@ ArcGisMaps
"é’fﬁ' ArcGisFeatu
* GeoMNode

Layers
(‘,( I@ ‘v Y EIJ
# School

Click New Field in the Attribute Table, HE:

+ | %" OSM Standard

’ Current Edits 4
Eilter...

Change Data Source...

Set Layer Scale Visibility...

Set CRS >
Export 4
Styles 4
Properties...

|

e

Q School = Features Total: 1, Filtered: 1, Selected: 0

7% 8 B & N 4

- [m]
EePlpkEE = @ e

123id H€| 1231

[New field (Ctri=w)]

id

1(NULL ‘

x

|| Update Al || Update Selected
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In the New Field Dialog Box put the name as 'Label' and change the type to 'Text (string)":

(2 Add Field X
MName Label |

Comment

Type | Text (string) -

Provider type string
Length 0 =

| I:DI{ || Cancel

A new column appears beside the Id column called Label. Type your school's name in the cell, e.g.:

Q School = Features Total: 1, Filtered: 1, Selected: 0
‘8B = B | & tTES D B RE
123id v |=| &

id Label

1 Crana College

Now click on the Save Edits icon of the Attribute Table:

Q School i Features Total: 1, Filtered: 1, Selected: 0
K 12| SR O & N
123id qﬁjave edits (Ctrl+S)|

id Label
1 Crana College

Close the Attribute Table by clicking the X:

Turn off Editing Mode by clicking the Toggle Editing, w icon. If it asks if you want to save layer edits, click
'Save'.

—~L
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7. Now we need to turn on the label in order to see it on our map. Right-click the School shapefile in

the Layers Panel and select 'Properties'.

v & XYZ Tiles "= Open Attribute Table
& OpenStreetMap | / Toggle Editing

@ WEs Filter

A7) WFS T

) OWS Change Data Source...

& ArcGisMapServer Set Layer Scale Visibility...

A ;

&) ArcGisFeatureServer Set CRS b

* GeoNode

Export d

Layers
o @ ® T & v F 0 VS '

Properties...

School
* /| == OSM Standard

In the resulting Box, select Labels and choose 'Single Labels':

" No labels

Single labels
Rule-based labeling
Blocking

» Source

Lorem Ipsum

Lorem Ipsum b|[1:3848 v | -

abe Text Rendering

Your map should now show the label of your school name, similar to below:

&0 WFS

& ows

@ ArcGisMapServer

& ArcGisFeatureServer

3 GeoNode
Layers %
s AT a-FX0

/_School ]
* « ¥ OSM Standard

Lrana College

i D7
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We will now export the map as an image. The export will be whatever is currently showing on

your screen. Drag the map around and zoom in or out until what you see is what you want to

export:

Project > Import/Export > Export Map to Image

@ *School-Lacation - QGIS

| New Ctri+M ;: 4;‘-':' 3’_ /-’{3

New from Template b = "'
Open... Cirl+0
Open From b
Open Recent b
Close

I save Cirl+5

F& Save As... Ctrl+Shift+5
save To b
Revert...
Properties... Ctrl+Shift+P
Snapping Options...

Import/Export

zwd Fdit View Layer Settings Plugins Vector Raster Web Mesh Progessing Help
L]
LI @@

RNE YRR

— frmiaina 422

&

4 E. Export Map to lmage...

i New Print Layout... Curl+P /g Export Map to PDF...
|e) New Repart... Export Project to DXF...
v;': Layout Manager... Import Layers from DWG/DXF...
Layouts b
Exit QGIS Cirl+Q

1

Don't change anything in the resulting Dialog Box and press Save.

Q Save Map as Image
w Extent (current: map view)

North |7388497.6047

West -830734.1266 East

South |7387793.8557

-829469.9849

Calculate from Layer ¥ Map Canvas Extent Draw on Canvas
Scale [1:3848] - |
Resolution 120 dpi
Output width | 1552 px =
Output height | 864 px =
| Draw active decorations: none
v/ Draw annotations
/| Append georeference information (embedded or via world file)
Copy to Clipboard Save Cancel Help

7

L [
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Save your map in a new folder called ExportedMaps within your QGIS folder; leave the file type as png, call the
map 'School-Location-Map' and press save:

Q Choose a file name to save the map image as

T » This PC »|Desktop » QGIS-FS > ExportedMaps

Organise ~ New folder

Powerpoint

Shapefiles

& OneDrive
Attachments
[ Desktop
= Documents
= Pictures
= This PC
¥ 3D Objects
[ Desktop v

File name] | School-Location-Map

Save as type] PNG format (*.png *PNG)

~ Hide Folders

Congratulations, you have made your first map! Your map shows your school's location in relation to the local
roads. Your map image file can be easily included in emails, on a poster, on social media posts, etc.

Of course, what we created is very basic — for instance there is no map title, a scale bar, or a north arrow, all
very important features of mapping. As you progress on this course your mapping skills will improve vastly,
and you will learn many other useful ways that maps can help solve problems and help in managing our
environment. More importantly, you will be allowed to be creative in your map production and by the end of
the course you will find that you have the skills to progress on your own!

~

What is a Plug-In? A plug-in is a software
component that adds a specific feature to an
existing computer program.

What is a Shapefile? This is a data storage

format for geographic information system
software.

/

.
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LESSON 2: MAP LAYOUT

LEARNING OUTCOMES:

e Understanding of map elements

BACKGROUND

Maps commonly have the following list of elements, which are also shown in red in the figure below:

e Title: This gives context about what the map is showing

e  Map body: This is the map itself with the features of interest

e North arrow: This gives orientation to the map information

e Scale bar: This indicates the distance covered in the map

e Map border: This frames the map to show where it starts and ends

e Legend: This explains what the symbols on the map represent

e Acknowledgment: This states who owns or provided the data that has been mapped

Title Common map elements

0.01 degree

Scale bar

Legend
Buildings
L ]

Contour lines

Lakes
| |

Rivers

P J1030 L]

Roads

Spotheigts

——== QOther Access
............ Track Footpath

AC know' eg ment I Data Source: GIS for Educators

Figure 5: Common map elements (source:

https://docs.qgis.org/2.14/en/docs/gentle_gis_introduction/map_production.html?highlight=scale).
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UscrooL

EXERCISE 2: INTRO TO THE PRINT COMPOSER

In the previous lesson we learned how to create a basic map. This lesson will develop your skills to show some
additional useful information commonly shown on maps.

Don't forget, all the steps are also demonstrated in the video tutorial, accessible here: https://cutt.ly/9jUZ7bE.

Objective:
e Produce a more 'complete' map with common map elements.
Task: Craft Fair Map Draft 2

Following on from Exercise 1B, the Craft Fair committee have a few edit requests for your map. You must edit
your map to include the following:

e Title: *School Name* Craft Fair Location Map e.g. 'Crana College Craft Fair Location Map'
e Map border

e Scale bar

e North arrow

Exercise 2 Steps:

1. Open the workspace that you created in Lesson 1 (School-Location):

IThis PC » Desktop » QGIS-F5 > Workspaces

L

Name Date modified Type Size
Shapefiles 13/06/2020 14:01 File folder
"% School-Location 15/06/2020 12:21 QGIS Project 7 KB

As you can see, your workspace remained the way that you left it. We are going to build on this project in
order to meet the requirements of the Craft Fair Committee's requests.

2. We save a new workspace so that your first workspace may act as a backup. Save this version as
'Craft-Fair' in the Workspace Folder using the Save As function.

O
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(2 save Project As

N

UscrooL

> This PC > Desktop > QGIS-FS > Workspaces

Organise ¥ New folder

vlo

= This PC
J 3D Objects
Il Desktop

|=| Documents.

~
Name

Shapefiles

"% school-Location

Date modified

13/06/.

2020 14:01

15/06/2020 12:21

Type

File folder

QGIS Project

Search Workspaces

¥ Downloads
I‘ Music
&= Pictures

E Videos

L. Windows (C)

i Network v

File name: | Craft-Fair

Save as type: QGZ files (*.qgz)

~ Hide Folders

3.

Save

Cancel

Make sure your school is in the centre of the map window. We will also specify the scale of the map
Set the scale to 1:5000 in the project settings at the bottom of the map window:

" &Lrana College
\a\
\ e T
N\ o \
g\ o T
\3,\ Christ
YA - Church
2. \
2\ ,‘
Ay \ A
\ P |
€ \ L \ ‘}1
« \ =1 \
[ Tt 1r1oon000 [~ ) [ AN T
& 1:500000 \=
1:250000 |z
1:100000 2
1:50000 2|
1:25000 ¥l
1:10000 \ =\
1:5000 \
1:2500 \
1:1000 -
Coordinate  -830092,7387772 % Scale | 1:5000 a4 & Magnifier| 100% +| Rotation |0.0° %| | Render €% EpsG:3857 Q

Now we need to add some features (title, scale bar, north arrow) that require the use of the QGIS

'Print Layout' tool. To access this tool click New Print Layout via the Project file menu option:
Project > New Print Layout

Print Layout
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(2} Craft-Fair - QGIS
Edit View Llayer Settings Plugins WVeq
j New Ctri+MN

New from Template b

Open... Ctrl+0
Open From b

Open Recent 4

Close

E Save Ctrl+S

B2 Save As... Ctrl+Shift+S
Save To b
Revert...
Properties... Ctrl+5hift+P
Snapping Options...
Import/Export 4

8 New Print Layout... Ctrl+P

TE—, Mew Report...
|~§ Layout Manager...
Layouts b

Exit QGIS Ctrl+Q

A dialog box requests a title for your map. You can insert 'Craft Fair' here. If you choose to leave it empty it will
automatically name itself 'Layout 1"

&
&
&£ /
(2 Create print layout Title b4 / /
h j,/
Enter a unique print layout title / /
(a title will be automatically generated if left empty) los ( [:
Ay,
[Craft Falr[ | e \ o\
| oK | Cancel \_\ \‘\
lk A\
b4 \ N
] \ O\
: College \
Srana College \\_‘
\

e
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Now your Print Layout Window appears. This window is where you can add other elements to your map and
then print it.

Layout Edit View ltems Addltem Atlas Settings

BRERDR B OB ! B8

APBAY BALAGEME

o 2 LSO 20O P O IO <O I < <O oo 220 ol PO o e P 20PN 2O 22 O 22 2 e =

= | ‘v General Settings
> 2 Reference map

[15] ?7, v Guides and Grid

ol A 10.00 2| mm
gt Grid offset

8 8- -

] Tems | MemProperties | Gudes | Atlas

= Item Properties

gl =

oo
5| ]

AT

&L

= By

/82
Rl

x:162.692 mm  y: 96.1692mm  page: 1 58.5%

(Q *Craft Fair - =] X

o|

5. Click on the Add New Map icon, |Eﬂ

QCraf‘tFair
Layout Edit View Items AddIltem Atlas Settings

BEROEDR B @8k &k
APPHAL BB O EOE

J |-8|D| I ‘_6|D| 1 ‘-4|D| 1 |-2|D| I ‘DI [ ‘2D| |

™
-40 |
1 1

-20|
(I |

[Hw =55
ol

Adds a new Map to the layout

L

o
& -

& 4

Your cursor changes to a crosshair so that you can drag a box on the blank page to place a map there. What
appears in the resulting rectangle is the current view showing in your QGIS map window. You can move and
resize this map by clicking on it and using the resizing handles and the boxes in the corners:

L
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J".o:l - I—l =
&
5?
3 o
¥
g A N
_ v 7 3
Q { G o
g 0"“?:;,%_ q&
¢ 3 g %
\.\ ;’_ .\ O\‘\.
T y ok
: Ed \ % =
% &rana College’, A :
6& “3 et e
5! P
D L W\ \
P 2 B c
L,\Gt'e'\ T\ l!j %
P NS I 2
o z
L%
5I.
X -1
p W Al
y
0 canan P 1 ol O
Leave a white border around the edges for printing purposes, and enough space at the top for a Map Title.

If you want to edit the map extent you can use the properties panel. Make sure the map is selected and then

4
in the Item Properties tab select Interactively Edit Map Extent, LE This allows you to pan and zoom

0
interactively within the map item. To treat the map like an object again, select the Select icon, h

v ] Map1
(R
Layout Item Properties Guides
P [tem Properties
o Map 1
. o EE ®ER Mg l=
o M|
e’%),s‘ w Main Properties | Interactively Edit Map Extentl
Note: If you need to leave your computer and turn off QGIS and you want to re-access the Print Layout, then

example see below where it shows Craft Fair:

you save the project before closing and the Print Layout saves alongside the Project File. After reopening the
Project workspace again, click the Project Menu Button and choose your layout within the Layouts option — for
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(2 Craft-Fair - QGIS

Edit View Layer

Settings Plugins Vector

j New

New from Template
Open...
Open From
Open Recent
Close

E Save

E Save As...
Save To
Revert...
Properties...
Snapping Options...
Import/Export

[ -} New Print Layout...

[} New Report...

|4 Layout Manager...

Ctrl+N

Ctrl+0

Ctrl+S

Ctrl+Shift+5

Ctrl+Shift+P

Ctrl+P

»

Raster

Web Mesh Processing Help

)-JONIO; 2 &M

=4 q= GG

@

Craft Fair

| ExitQGIs

Ctrl+Q

@ WGs

7 WFS

Layers

o @ & T &~ 0

v @ School

v || =® OSM Standard

Fishing
Greens

Gym

@&

5 Y

The Print Layout window will be as you left it. Practice saving and reopening your Print Layout now.

6.

We add map titles to explain to the reader the purpose of the map. To do this we use the 'Add Label’

icon, !:

Grounded - Explore your world
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where you clicked:

Click on the page, above the map, and a dialog box will appear showing information regarding the position of

(:d New Item Properties x
Position and Size Reference Point
Page 1 =
& Casyy,
@ “Pﬁwm@ | X 31.327 = *
5 / mm v
g‘“ N Y 28.363 =
& \]

) i / Width 254.523 2| 1

° Stieg, m mm v

g L Height 163.415 = 4

] %

N

4 \

£l rena College ',

5 ko oK Cancel Help

2
& D, 2
By > 1 | |
P % P
P et o
e # \
$2
P

Leave the numbers as they are and press Ok. A label saying 'Lorem ipsum' will appear at the top of the map as
well as in the Item Properties. This is default text for you to see it and replace with your own text. Type in your
title into the Item Properties box instead: Add the requested title '*School Name* Craft Fair Location Map'. As
you type you can see the text appearing in label box on the map canvas:

[T

10.00

</ mm
Grid offset
O

Iems | Ttem Properties | Guides
Item Properties
Label

Atlas

o
et

v Main Properties

Crana College Craft Fair

Render as HTML

Insert an Expression...
v Appearance

Font -~
Font color T -

Horizontal margin | 0.00 mm

The label can be resized and moved in the same way that you resized and moved the map. The font size and

right.

colour can be modified using the Appearance options underneath the main properties in the panel to the

7.

Make the title centred over the map by doing the following:

Title are now selected.

Click on the map. Then, hold down Shift on your keyboard and click on the Title so that both the map and the

Find the Align icon and click on the dropdown arrow next to it to reveal the positioning options and select
Align Center, :

Grounded - Explore your world

30

V-

U
Science Sfl
Foundation

Ireland For what's next



Ul

QGIS

SCHOOL

Q *Craft Fair

Layout Edit View
Bk
POPHS

-80
[

B e

-60
[

-40
[

-20
[

-20| -40| |
[ il

oA
[

20
[

O BEEYG

40

Items Add ltem Atlas Settings

BmE 998
o [

B b h &
B Johs B

Align Left

124

| Align Right

“I7 Align Top
== Align Center Vertical
ol Align Bottom

Crana College Craft Fair 1
1

8.

=
Select the scale bar icon, :

Now we include a scale bar to indicate distance on the map.

Add scale bar

40
|

tH[

|IF|D||I

ol

)

a
/o |8

Adds a new Scale Bar to the layout

r

|..'
|1
=
Q
2
=
a
=1
w©
Tal

Click on the position of the print layout canvas where you wish to place it. A scale bar will be added to the
canvas. You can move the scale bar like the previous items we added.

T
S
i '*%
h%\te‘f‘ 2 U
- | P o '
o 106 200 \ \
E A ..
0 ] !

Grounded - Explore your world

31

U
Y d
Science S I
Foundation

Ireland For what's next



UscrooL

9. Next we show orientation on the map by adding a north arrow. Click on the

North Arrow icon, A :

Add north arrow

[+

o M

m
a

60| 40‘ 20|
[ T T T e

b

Adds a new North Arrow to the layout

o E o

Click on the map where you want to place the north arrow.

If you'd prefer a different type of arrow, on the right-hand panel, click on the Item Properties tab and expand

the Search directories section and select the arrow image of your liking.

Referance map Map 1 -
v Guides and Grid
Crana College Craft Fair Logation Map Grid spacing
umon 10.00 3 mm -
e Gt ‘ ‘ Grid offset
Y b YA Rems Guides | Atias
d 3 ! N Item Properties EE
/ . i ;
y e C:/0SGEO4~1/apps/qgis/sva/arrows/NorthArrow_04.svg r=E
/ Resize mode
g ot Zoom v
3 Aty Placement
A
H Top left -
’ &rana College '\
) i WA R i) FiF a0l m@@»
f’-»,;\ ~ = :(:E:;. @ LY Wa ﬁ‘P S ﬁm@m
# $AA | \v\qm@»& T
\ gt | AAGCOOBSHES 6 A
o \ \ % A4\ n /\@A{E A**@%UY(“%@
NE i DHBI0galUMLS—me
0 100 200 m = g\ FAAa « hoilli €a M viEH FA -
L, I— | \2\ Image search paths
i . " C:/OSGEO4~1/apps/qgis/svg \/
Grounded - Explore your world 32

e Sfl
Foundation

Ireland For what's next



UscrooL

10. Finally, we make the map look neater by framing it with a map border.

Select the map. On the right-hand panel, click on the Item Properties tab and tick Frame:

40 P B0 B B, et 2
—_—_— General Settings
Reference map | | | Map 1 b
w Guides and Grid
Grid spacing
10.00 | mm -
T
Grid offset
- -
Ttems Guides Atlas
- Item Properties B
o Map 1
e ane SERER OB =
-
¥ Extents
X min -830779.069 [EN
¥ min | 7387771.775 [E8
[ X max -820473.914 [EN
Y max |7388535.488 (=N
Controlled by Atlas
» Grids
P Overviews
\ P Position and Size
A
z|
L
2|
1\ In
Thickness | 0.30 S |mm ~
Join style “ Miter -
P | Background
i A TEam TN b
x:323.914 mm  y: 171.917 mm  page: 1 77.6% v | =
|
11. Now we are ready to export our map! Export as PDF
Click Layout > Export as PDF
(@ *Craft Fair
Edit View ltems Addltem Atlas Settings
E Save Praject Ctrl+S E o
[ 5 New Layout... Ctrl+N b B
L) Duplicate Layout... il
_ 60 |E[I |1nn
I Delete Layout... (RERNRRERE EXRRNRERRY NRRRRAT]
[ 2'3, Layout Manager...
Layouts 4
Layout Properties...
Rename Layout...
fj Add Pages...
Add ltems from Template...
Co;
E Save as Template... 4
=& Export as Image... £
13 Export as SVG... 5{;
&
Page Setup... Ctrl+Shift+P
@3 Print... Ctrl+P o
g &
Close Cctrl+Q S £
e — g 2
il EE 3 3
I fric4 L4 !
Save your map in your ExportedMaps folder.
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Leave the PDF Export Options as they are and click Save:

w Export Options

Format

Layer

Q PDF Export Options

Always export as vectors
v | Append georeference information
v/ | Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) v

v Create Geospatial PDF (GeoPDF)

Include multiple map themes

V| Include vector feature information
Uncheck layers to avoid exporting vector feature information for those

layers, and optionally set the group name to allow multiple layers to be
joined into a single logical PDF group

v School
OSM Standard

w Advanced Options

Disable tiled raster layer exports

v/ | Simplify geometries to reduce output file size

IS0 32000 Extension (recommended)

PDF Group

| Save N Cancel Help

12. Well done, you have acquired the skills to make a complete map! Remember to mark your progress

on the Goals Sheet in Appendix A.

Grounded - Explore your world

-

PDF versus PNG: PNG is a top choice if images
will be edited and saved multiple times. PDF
images are ideal for printing, especially for
graphic design, posters, and flyers. PDF images
are also an ideal choice for storing images
online when you intend them to be downloaded

~

N /
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LESSON 3: QGIS FOR MANAGEMENT DECISIONS

LEARNING OUTCOMES:

e Introduction to coordinate reference systems
e Linking environment with mental health
e Consideration of accessibility requirements

BACKGROUND

The WHO (World Health Organisation) recommends a minimum of 9 m? of green areas by person, in urban
areas. Green areas are public spaces dedicated for recreation/leisure. This is because green space has been
recognised as key for people's mental wellbeing. Research indicates that the amount of green space for
individuals is potentially linked with higher rates of depression and other mental health disorders.

Which city or towns in Ireland do you think have high or low amounts of green space per person?

Curitiba city in Brazil has one of the greatest areas of green space per person, with 52 m? per person, followed
by New York, Madrid, and Santiago, Chile. Among the cities with the least green space per person are Tokyo

and Buenos Aires with 1.9 m2.

Figure 6: (source: https://www.jnj.com/innovation/how-johnson-johnson-is-helping-rethink-how-we-treat-
mental-healthcare)

RESOURCES

https://plusnetwork.wordpress.com/2011/07/13/how-many-metres-of-green-space-does-your-city-
have/#:~:text=The%20World%20Health%200rganization%20(WHO,and%2015%20m2%20per%20person.

e
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EXERCISE 3: USING QGIS TO MEASURE AREA

We will develop our GIS skills by solving some more real-world type problems. This Exercise will gather
information about your school area for use in practical management decisions.

Don't forget, all the steps are also demonstrated in the video tutorial, accessible here: https://cutt.ly/9jUZ7bE.

Objective:

e Touse QGIS to delineate and measure areas.
e Torealise the utility of Geographic Information Systems for the analysis and presentation of spatial
information, and for supporting decision-making processes.

TASK: School Green Spaces

The government is doing an inspection on all schools to make sure that they are adequately designed to have
enough 'green space' for student wellbeing.

You have been tasked with creating a map for the Inspector, showing the amount of green space in the school
grounds. You are also asked to address the following questions:

1. What percentage of the school grounds is allocated to green space?
Are the green spaces being used effectively (can they be enjoyed)?
Is there enough done to cater for people with accessibility requirements? Include any suggestions.

Note — if your school has zero green space, you can complete this exercise to work out what percentage of
grounds is allocated to car parking instead.

Relevant Sustainable Development Goals:

GOOD HEALTH 1 REDUCED
AND WELL-BEING INEQUALITIES

A

® ()

h 4

O
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Exercise 3 Steps:

1. To practice creating a project we will not use any of our previous workspaces. Open QGIS and save
the blank Workspace as 'School-Green' (Project> Save As).

raey

2. Add base mapping using Quick Map Services, N OSM Standard (like Exercise 1B):

12 Genshtab 4
#> Ukraine Cadastre 4
& Waze »

0OSM Cycle ma
9 Yandex » @ ¥ P

/- 0OSM Humanitarian
= Bergfex 4

0SM Standard
eAtlas Mos 4
@ OSM TF Landscape
0SM 3

(@ 0SM TF Outdaors
Search OMS Panel

@ OSM TF Transport Dark
Add to Search 3
@ OSM Transportation
#= 0OSM Veloroad
# OSM2World/3D (DA CH)

‘%{g Set proper scale

‘fi@ Settings

€9 Ancurt

Note: Using coordinate reference systems (CRS) every place on the earth can be described by a set of three
numbers, called coordinates: x, y and z.

e x(east—west or longitude)
e vy (north —south or latitude)
e z(depth/elevation or metres)

The base map we added automatically made our workspace coordinate reference system update to EPSG code
3857, shown in the bottom right of the workspace:

Coordinate| -13559328,3797164 | Scale|222849137 ~ | @ Magnifier| 100% | Rotation [0.0° ||V Render [2 Epsgians7 | @

.
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Clicking on the EPSG code gives information about the coordinate reference system:

(2 Project Properties | CRS X

Project Coordinate Reference System (CRS)

General
. No projection (or unknown/non-Earth projection))

Filter | €L

Recently used coordinate reference systems

Coordinate Reference System Authority ID =
¥ Default Styles TM6S / Irish National Grid EPSG:29900
B Data Sources WGS 84 EPSGi4326
WGS 84 / Pseudo-Mercator EPSG:3857 -
EE Relations 1 r
Coordinate reference systems of the world Hide deprecated CRSs
Variables
ordinate Reference System Authority ID =
x® Macros WGS 84 / PDC Mercator EPSG:3832

WGS 84 / Pseudo-Mercator EPSG:3857
4 3

QGIS Server

WGS 84 / Pseudo-Mercator -

WKT
PROJCRS["WGS 84 / Pseudo-
Mercator”,
BRSEOEODCREIMNES A4

¥ Datum Transformations

/| Ask for datum transformation if several are available (defined in global setting)
g =

Source CRS Destination CRS Operation

‘ oK Cancel Apply Help

We can see that we are operating in 'WGS 84/ Pseudo-Mercator'.

3. Change the coordinate reference system of your project to IRENET95 / Irish Transverse Mercator as
this is the most accurate projection for Ireland and will generate more accurate area calculations. Use
the Filter search box to help you: input the EPSG code 2157, and select the coordinate reference
system to highlight it blue, select Apply and then press Ok:

() Project Properties | CRS X

Project Coordinate Reference System (CRS)
e
© szl No projection (or unknown/non-Earth projection)

! Metadata Filter|| C. 2157 a

Recently used coordinate reference systems

= Coordinate Reference System Authority ID
- el IRENETO5 / Irish Transverse Mercator EPSG2157
E Data Sources
EE Relations 4 4
Coordinate reference systems of the world Hide deprecated CRSs
Variables
ordinate Reference System Authority ID =

@ Macros

I IRENET9S / Irish Transverse Mercator EPSG:2157
QGIS Server NAD83 / Wyoming West Central EPSG:32157 =
3
4 3
IRENET95 / Trish Transverse Mercator = !

WKT i
PROJCRS["IRENETS5 / Irish Transve
rse Mercator",

BASEGEODCRSI"TRENETSS™ .

¥ Datum Transformations

/| Ask for datum transformation if several are available (defined in global setting)
| (=

Source CRS Destination CRS Operation

| oK ‘ ‘ Cancel Apply Help

Science
Foundation
Ireland For what's next

.
Grounded - Explore your world 38 /)“gfl



UscrooL

I/+/I ,-/
Now, you need to find your school. Zoom in to your school location using the zoom icons, <~ ¢,

or your mouse wheel (example shown below is Crana College, Co. Donegal):

5
f Ol
R238

£
Aoy

Rockfield Terrace

e et
o

q;' s

LA

FA

et
Lot
o
o

PrITEL A

Buncrana

Are the site bounds of your school obvious? In the map above only the school main building is clear, the actual
entire site area (i.e. including car parking and green space) is not outlined. How do we get around this? A very

quick and useful method is to consult satellite imagery.

First we will install some extra features on the Plug-in. Click on the Quick Map Services icon,

5.
and select Settings.

Science
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On the More Services Tab select Get contributed pack and Save. Ignore any warnings.

Grounded - Explore your world

Qe -

& 2gis

@ AutoMavi

b Bing

& esri

@ GeoQ

[] Geofabrik

& Google

m Kosmosnimki.ru
@' Portugal

/ ! Landsat

¥ MapSurfer.NET
) Mapbox

@ NAsA

= Georgia

& CartoDB

“ Rosreestr
' OpenSeaMap
£ Sputnik

~4y Stamen
strava

4 usss

222 TianDiTu
:ﬁ'f Genshtab

=% Ukraine Cadastre

B & Waze

9 Yandex

n Bergfex

n eftlas Mos
» OSM

(£} Search OMS
(@ Add to Search

L (@ Set proper scale

ﬂﬂ About
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(3 QuickMapServices Settings x

General Tiles Add\Edit\Remowve Visibility More services D}

Attention!

Contributed services definitions are provided 'as is' and are not validated by plugin
authors. These are proof-of-concept and for testing only. Visit https://github.com/

nextgis/quickmapservices contrib to add new services. Use at your own risk!

Get contributed pack |

| Save Cancel

-
6. Now, click on the Quick Map Services icon, iia and select Google > Google Satellite:

Qz 2gis 4
@ AutoNavi 4
- Iq@ 9 > Bing 4
ESRI y
@ GeoQ 4
[<] Geofabrik y
i m Google Hybrid
@ Kosmosnimki.ru 4 VA’ Google Labels
@ Portugal » m Google Road
| B Landsat 4 ‘A Google Satellite
iﬁé MapSurferNET » m Google Terrain
@ Mapbox v | ¥ Google Traffic
@ NASA » | Z¥ Google.cn Normal
A “ Georgia » VA’ Google.cn Satellite
;_. ¢ CartoDB » Y v’
E 4 “ Rosreestr » P
n OpenSeaMap » B p
< Sputnik » B
. en »

Now we can see the carpark, main building, support buildings, basketball courses, green areas, etc. If you're
still not sure about your site bounds you may want to do a walk-around, but make sure to ask permission first!

7. To outline the school site we'll draw a polygon around the school site bounds. To do this we create a

shapefile: Drawing polygons

e
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Menu Toolbar > Layer > Create Layer > New Shapefile Layer

I=) #School_Design - QGIS
Project Edit View [EWEd Settings Plugins Vector Raster Web Mesh Processing Help

D m ‘!Qaia Source Manager Ctrl+L |m “1 |m Ej q1
Create Layer » G?] New GeoPackage Layer... Ctrl+Shift+N
BQV. A4 ‘
[ Il %)

Add Layer »
o-Fr

[Browser
TRTYTHO

Favorites

, New Shapefile Layer...

,fj New Spatialite Layer...

Embed Layers and Groups...
Add from Layer Definition File...
B Copy Style

Docio Cn

ﬁ New Temporary Scratch Layer...

Ml New Virtual Layer...

O SN

Save the shapefile in the Shapefiles Folder in the Workspaces Folder, with file name 'School-Area'. Change the
geometry type to Polygon. Make the Coordinate Reference System Irish Transverse Mercator (remember it is
code 2157):

@ Coordinate Reference System Selector X
Filter | L

Recently used coordinate reference systems

Coordinate Reference System Authority ID
TM®65 / Irish National Grid EPSG:29800
WGS 84 EPSG:4326
WG5S 84 / Pseudo-Mercator EPSG:3857

IRENETSS / Irish Transverse Mercator EPSG:2157

4 % 4

ICoordinate reference systems of the world Hide deprecated CRSs
Coordinate Reference System Authority ID =

IGN 1963 UTM Sud fuseau 7 IGNF:IGMNE3UTMTS

IGN53 Societe UTM Sud fuseau 5 IGNF:RAIAS3UTMSS

IGN72 UTM Sud fuseau 58 IGNF:IGNT2UTMS585

IREMETA5 / Irish Transverse Mercator EPSG:2157

Indian 1960 / TM 106 NE EP5G:3176

Israel 1993 / Israeli TM Grid EPSG:2039

Israeli Grid 05 EP5G:6984

Israeli Grid 05/12 EP5G:6991

JGD2000 / Japan Plane Rectangular CS 1 EPSG:2443 =
4 »

IRENET95 / Irish Transverse Mercator - _;é_:\ N

——
wir /;Aﬁ \’-
PROJCRS ["IRENETSS / Irish Tramn — }3‘3
sverses Mercator™, «gjw_

BLSEGECDCRS ["IRENETSE™,
DATUM["IRENETSS", T
ELLIPSCID["GRS 198
o",6378137,298.257222101,
LENGTHUNIT [ "me S ,-—-Jl"-%

tre", 1711, “i.:_{' T,S’-""

PRIMEM["Greenwich™, 0, |™

| 0K | | Cancel Help

Leave all other options as they are and press Ok.

The School-Area shapefile will appear in your Layers Panel. Right-click and select 'Toggle Editing'. You will see
the yellow pencil appear in the Layers Panel.

0
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Browser
ORT®XTO
7 Favorites
IV Spatial Bookmarks
[&] Home
O
‘ﬁ GeoPackage
f Spatialite
W@ rostals
P mssal
@ Oracle
£ oe2
& WMS/WMTS
v @ XYZ Tiles
I OpenStreetMap
@ wes
&7 Wrs
) ows
@ ArcGisMapServer
"fq" ArcGisFeatureServer

v v v v

Layers
o @l w T &~ & O
v = 0SM Standard

School-Area
* || #* Google Satellite

5D Zoom to Layer
Zoom to Selection

% Show in Overview
Show Feature Count
Copy Layer
Rename Layer

D Duplicate Layer

Q Remove Layer...
Move to Top

“= Open Attribute Table

£ Toggle Editing
Filter...
Change Data Source...

Set Layer Scale Visibility...

Set CRS

Export

Styles

Properties...
Wil -
; R R -
D

Select the Add Polygon Feature icon on the Vector Toolbar, L2 This changes the cursor into a crosshair.

Settings Plugins
Oe 2
L AV
q -

&

8

|

123

T

Click on the first corner of your site and start to trace out the site bounds. As you click your

Vector Raster Web Mesl

PHPP]

ol

Add Polygon
Feature (Ctrl+.)

(Q
+8

polygon

forms. If you make a mistake i.e. put a vertex in an incorrect place, continue on and you can edit it after.

When you get to the end of your area, right-click to close the feature. In the resulting Feature Attributes
dialog change the id from NULL to '1' and press Ok.

Grounded - Explore your world
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School-Area - Feature Attributes

Actions

id [NULL |

0K | | Cancel

e
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8. To check whether the bounds of the polygon are accurate, and to incorporate any edits, change the
symbology of the layer to make the interior of the polygon transparent:

Right click the layer in the layers panel > Properties > Symbology > outline red

(2 Layer Properties - School-Area | Symbology ke
- = Single symbol -
3 = &
= Simple line
Unit Milimeters -
Opadity 1 100.0 % E
Color i
B8 Attributes Form
Joins 1, Favorites a |~ | 8
ece
L L
ons [, L
- Deple gradient gray 3 fill hashed black/ hashed black \ hashed black X outline blue outline green outline xpattern
> plasma
& Rendering
YvYvy
Varizbles LA 4
AA 4
! Metadata
patten dot black  pattemzelda  simplebluefill  simple greenfill  simple red fill
B Dependencies
= outline red Save Symbol... Advanced ~
P Layer Rendering
B vigticing - Swle - ok | cancel Apply Help

9. Now, if you wish, edit the vertices by using the Vertex Tool, fg{:
e To change a vertex location, click on the vertex and then click on the location where you want to
place it.
e To delete a vertex, click on it and press delete on your keyboard.
e To add a vertex, click on a line of the polygon and then drag the new vertex out to its desired
position.

NOTE: Often, instead of editing the polygon, it is easier to delete it entirely and start again. To do this, select
the polygon to highlight it yellow and press delete on your keyboard.

e
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Once you're happy with the polygon shape save your edits, E and click Toggle off (click the yellow pencil in
the toolbar or right-click and deselect toggle editing) to stop editing.

10. To calculate the area of your site select Vector > Geometry Tools > Add Geometry Attributes:

Calculating area

I *School_Design - QGIS
Project Edit View Layer Settings Plugins @Eaﬁer Web Mesh Processing Help
D = @ es @ E} ﬂ-) Check Geometries... [El E Q& — E{E =R qg E
Shape Tools 4 § ;
- a
- ‘/ Geoprocessing Tools A EEE {@ @ .
- =) Centroids...
Browser Analysis Tools 4 "3 Collect Geometries... f
ﬂ DRT®*O Data Management Tools b | %" Extract Vertices... 180
@ 77 Favorites Research Tools » | 57 Multipart to Singleparts... o I i
] : |
OV; v I Spatial Bookmarks & Polygons to Lines... W
» [8) Home - ot
/’Ej r [JCA L Simplify...
o » & GeoPackage +/ Check Validity...
f Spatialite @ Delaunay Triangulation...
PostGIS oo
@ ; M;SQL Densify by Count...
@ Oracle Geometry Attributes...
@ DB2 P Lines to Polygons...
@ WMS/WMTS - Voronol Polygons...
~ &8 XYZ Tiles
=" OpenStreetMap

@) ows
& ArcGisMapServer
Layers
o 0 & T &~F I 0
School Area

Note: Vector layers are data stored in lines, points and polygons. They are commonly stored as shapefiles.

L
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In the Add Geometry Attributes window make sure the School-Area shapefile is chosen as the Input Layer and

calculate using Layer CRS (Coordinate Reference System): ol e S

() Add Geometry Attributes X
4
Parameters | Log Add geometry
Input layer attributes
L':;:' School_Area [EPSG:2157] v L &€ || @ This algerithm computes geometric
properties of the features in a vector layer.
Selected features only It generates a new vector layer with the

same content as the input one, but with

Ealciilat=gising additional attributes in its attributes table,

|| Layer CRS I_ % - containing geometric measurements.
Added geom info Depending on the geometry type of the
vector layer, the attributes added to the
[Create temporary layer] table will be different.

+| Open output file after running algerithm

0% Cancel

Run as Batch Process... | Run | | Close Help

Press Run and Close. A new temporary shapefile (called a 'scratch layer') has appeared called 'Added geom
info'. Scratch layers are deleted once you close the QGIS program.

11. Right-click the Added geom info layer within the layer panel and open the Attribute Table:

/# Spatialite ] Duplicate Layer
@ @ rostais [l Remove Layer...
P mMssaL -
@ Oracle B2 Open Attribute Table
& ps2 // Toggle Editing
€ WMS/WMTS Filter...
v & XYZ Tiles
Ch Data 5
=" OpenStreetMap ange Uata >ource
WCS Set Layer Scale Visibility...
SetL Scale Visibili
W Wrs Set CRS ,
) ows
Make Pe .
&9 ArcGisMapServer (5 Make Permanen .
B = Export .
Layers B
Styles b
! lm % T &~ [ !
Properties...
Added geom info
v School_Area
v = OSM Standard
+ /| 3 Google Satellite .

The area can be read from the new field which was added to the generated shapefile:

0
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Q Added geom info i Features Total: 1, Filtered: 1, Selected: 0

J ] & A K
id area | perimeter
8054.448660943...| 346.253667590...

In the above example the area is 8054 m?. If we close the project this scratch layer won't be saved. To

keep it permanent we need to export it as a shapefile. Right-click > Export > Save Features As:

Layers

<

* V| ¥ Google

Added geom info
|| School-
hd ¥ 0SM Standard

o @ ® T &-@ @0

Area

Satellite

}:‘-‘ Zoom to Layer
Zoom to Selection

n-g Show in Overview
Show Feature Count
Copy Layer
Rename Layer

[L] Duplicate Layer

[ Remove Layer..

~ Open Attribute Table

4 Toggle Editing
Filter...
Change Data Source...
Set Layer Scale Visibility...
Set CRS L

5 Make Permanent...

Save Selected Features As...

Styles

Properties...

Save as Layer Definition File.,
Save as QGIS Layer Style File...

Use the three browsing dots beside the File Name,

, to save it within your Shapefiles folder:

(@ save Layer As

X R save Vector Layer as... *

I

h 4 [« QOISFS > Shapefiles v | ® O SearchShapefiles

E Organize = Mew folder B> @ | Fename
Comtasiavids  ~  Name Date modified VA e _
My C ;

i W ourse [ school.shp s [ers EPSG:2157 - IRENETSS / Irish Transverse Mercator | || ®

i Sur [7] school-Area.shp Shw

| Video-Scripts v € >

i Encoding UTF-8 -

l File name: | TN ~] Save only sdlected features
Saveastype: [ESRI Shapefile (*.shp *SHP) | ~ || b Select fields to export and their export options

~ Hide Folders

¥ Geometry

Geometry type Automatic -

Force multi-type

Include z-dimension

B || Extent (current: layer)
w Layer Options

RESIZE |NO -

SHPT -

b Custom Options

V| Add saved fik to map oK Cancel Help

e
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12. Now we need to repeat the process to create polygons for the green spaces (or parking space if your
school doesn't have any green areas).

Create a new shapefile (Layer > Create Layer > New Shapefile Layer) and call it 'Green-Space' (or Parking),
saving it within the Shapefiles Folder:

) New Shapefile Layer x

File name ana'\OneDrive’\Desktop\QGIS-FS|Shapefiles\Green_Space.shp

File encoding System - -

Geometry type v

Additional dimensions (@) Mone Z (+ M values) M values
EPSG:2157 - IREMET95 [ Irish Transverse Mercator v -

New Field

MName I"\5

Type | abec Text data

Length |80 Precision
Add to Fields List
Fields List
Name Type Length Precision
id Integer 10

Remove Field

| oK | Cancel Help

13. As before, edit the shapefile (right click, Toggle Editing — Add Polygon Feature) and trace around the
first green area within the site bounds. Close the polygon, give it an id of '1' and then start the next
polygon around the next green area, giving that the id of '2' and so on. Keep doing this until all green
areas within the site bounds are traced (only two areas in following example):

O
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14. Add the geometry attributes as before (Vector > Geometry Tools > Add Geometry Attributes), make

sure the Input Layer is Green-Space.
15. Check the area calculation of the generated 'Added geom info' scratch layer as before (Right-click >

Open Attribute Table). There will be individual areas for each polygon drawn:

Q Added geom info :: Features Total: 2, Filtered: 2, Selected: 0
4 ] g LT E & D
id area | perimeter

1 | 343.5146484375 | 138.974392026...

2 515.688110351... | 127.621137666...

16. Export the scratch layer shapefile (Right-click > Export > Save Features As) to make it permanent,
calling it 'Green-Space-d02'.
17. Sum the area of green space. Now you can answer Task Question 1 by calculating what percentage of

the school is green space:
Area of Green Space

Area of School Site

X 100%

18. Before we produce the map we will change the symbology of the areas to be slightly transparent, in

order to have the school site visible underneath. Changing opacity of layers

Right click on the Green-Space layer and select Properties. Within the Symbology tab you can change the
colour here to whatever one looks best for your map. Change the Opacity from 100% to 50%:

() Layer Properties - Green-Space | Symbology

Q E Single symbol

@ irformation - [ mn &
. Simple fill

J\:\\ Source

€1 Labels

a Diagrams Unit | Milimeters

Opacity | 50.0 %
Calor

Turn off the Green-Space-d02 and the Added geom info layers by ticking them off in the Layers Panel.

vl !

4

q
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19. Now select New Print Layout to produce your map like before (see Exercise 2). Give the Print Layout
the title 'Green Space' for future reference:

(X Create print layout Title X

Enter a unique print layout title
(a title will be automatically generated if left empty)

|Green Space |

| OK | Cancel

Add at least the following items, in whatever way you think looks best for your map:

e  Framed map showing green space areas and school site area
e Map title

e North arrow and scale bar

e Date created and author

Green Areas within School Site

Date Created: 09/12/2020
Author: Fiona Stapleton

20. Export your map as a PDF and call it GreenSpace within your ExportedMaps folder.
21. Well done! You have created another useful map. Now answer the rest of the Task questions and
don't forget to mark your progress on the Goals Sheet in Appendix A.

~

Coordinate Reference Systems

Different coordinate reference
systems use different mathematical
rules, specifying how coordinates are
to be assigned to points.

- /

e
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LESSON 4: QGIS FOR ENVIRONMENTAL DESCRIPTION

LEARNING OUTCOMES:

e Link between environment and tourism

BACKGROUND

DESCRIBING THE NATURAL ENVIRONMENT:

Basic elements that control the features of our natural environment include the soil, bedrock, aquifers,
topography and hydrology. Short definitions are given as follows:

Subsoil: material on the immediate surface of the Earth.

Bedrock: the hard, solid rock exposed or buried under soil at the earth's surface.

Aquifer: underground layer of rock or sediments that holds groundwater.

Aquifer vulnerability: the ease with which groundwater may be contaminated by human activities.
Topography: the elevation and depression of the land surface (mountains, valleys, sand dunes).

Hydrology: the study of the distribution and movement of water (rivers, lakes).

OVERTOURISM

It is important that attractions don't suffer from overtourism. Tourism can be a contributing factor to
destructive effects such as air and water pollution, soil erosion, depletion of natural resources and destruction
of important wildlife habitats.

The Cliffs of Moher received 1.6 million visitors in 2019. The infrastructure and arrival facilities at the site were
designed to cater for 400,000 visitors a year. The number of visitors is projected to rise to almost two million
by 2025. What pressure is this putting on the environment and/or the tourist attraction itself?

RESOURCES

e https://www.independent.ie/business/irish/climbing-numbers-tourists-overwhelm-facilities-at-the-
cliffs-of-moher-38199713.html

e  https://www.gsi.ie/en-ie/programmes-and-projects/groundwater/activities/understanding-ireland-
groundwater/aquifer-classification/Pages/Aquifer-categories-and-types.aspx

9
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EXERCISE 4: USING QGIS TO INVESTIGATE GEOLOGY AND
HYDROGEOLOGY

Don't forget, all the steps are also demonstrated in the video tutorial, accessible here: https://cutt.ly/9jUZ7bE.

Objective:
e Use QGIS to find out some environmental information about an area.
Task: Cliffs of Moher Viewing Platforms

You are an environmental consultant in an engineering firm. Your company has won a project to develop
accessible sight-seeing viewing platforms at the Cliffs of Moher in County Clare. The attraction is hoped to
alleviate the numbers of people crowding at the one location at the cliffs at any one time. It also aims to open
up more areas for wheelchair users. This measure is believed to improve safety, reduce pressures on the
environment and increase visitor satisfaction (including reducing inequality).

As part of the Planning Permission process the company needs to submit an Environmental Report about the
site location. This is because in order to protect the environment, we must first describe it, as the appropriate
protective measures will depend on the nature of the landscape as well as the type of attraction being built.

For the Environmental Report you need to answer the following questions:

e  What is the bedrock at the Cliffs of Moher Interpretive Centre site?
e  What is the aquifer category?
e How faris the nearest river to the centre?

Figure 7: Viewing platform example (source: https://cutt.ly/Kj557Ld).

Relevant Sustainable Development Goals:

15 LIFE 1 REDUCED
ON LAND INEQUALITIES

A

(=)

h 4

e
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UscHool
Exercise 4 Steps:

1. Download the geology data from: https://cutt.ly/zjYnuhg (called GSI_Bedrock_500k)*. Press the
download icon (highlighted in the figure below).

Downloading open source data

< C {Y @ drvegooglecom/file/d/1GICHdD=BVssE wucwERhCISWTCTszK fvie a#ax 0

GSI_Bedrock _500K.zip 2=

"
"
b
]
"
&
B
.
[]
.
.
&
.
"
B
.
.
5
.
.
"
&
.
B o

Save this zipped file into a new subfolder called 'Data’ within your QGIS folder.

€ Save As *
« v 4 > ThisPC » Desktop » QGIS-FS » v | O Search Data
Organize « Mew folder == = 0
o~
J 30 Objects " Mame Date modified Type Size
[ Desktop
Mo items match your search.
1= Documents
4 Downloads
J’l Music
&= Pictures
Vidane o 2
File name: | G5I_Bedrock_500k “
Save as type: | Compressed (zipped) Folder w

» Hide Folders Cancel

2. To access the data we right-click the folder and select 'Extract All':

" Contains Irish Public Sector Data (Geological Survey) licensed under a Creative Commons Attribution 4.0
International (CC BY 4.0) licence.

Science
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« v 1 > This PC > Desktop > ~ ) | Search Data P
~ Name - Date modified Type Size
st Quick access :
B Desciop  # ¢ GSI_Bedrock_5r= open S Compressed (zipp.. ST
¥ Downloads  # Open in new window
|5 Documents  # © Share with Skype
=] Pictures » | Extract All. |
Images 7-Zip Iy >
My Course CRC SHA >
NUIG-QgisCours w Pin to Start
1item  1item selected 445 MB ER scan with Windows Defender... =

The next dialog box asks where to save the extracted files. By default, it will extract the contents to the same
directory in which the zip file resides. Just hit extract and a folder will be created that has all of the unzipped
files in it:

Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder;

CAUsers\fiona\OneDrive\Desktop\QGIS-FS\Data\ GS1_Bedrock_500k Browse...

Show extracted files when complete

3. Open QGIS and save the blank workspace as 'Environmental'.

~&
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4. To add the geology data we click Layer > Add Layer > Add Vector Layer:

Adding vector files

Ental-R - QGIS
View | VY | Settings  Plugins Vector Raster Web Mesh Progessing Help
a [EEa .[mata Source Manager Ctrl+L [E E [E %
Create Layer »
: .+ Add Vector Layer...
Embed Layers and Groups... '_, Add Raster Layer...
ﬁ ’_} Add from Layer Definition File... ﬁ Add Mesh Layer...
= Copy Style 9., Add Delimited Text Layer...
T Paste Style .:; Add PostGIS Layers...
Fvorites Copy Layer /ﬂ Add Spatialite Layer...
Bpatial B Paste Layer/Group ’_, Add MSSQL Spatial Layer...
:;1::: H  Open Attribute Table 6 [, Add DB2 Spatial Layer...
L Toggle Editing E Add Oracle Spatial Layer...

Ctrl+Shift+V
Ctrl+Shift+R

Ctrl+Shift+T
Ctrl+Shift+D
Ctrl+Shift+L

Ctrl+5Shift+2
Ctrl+5hift+0

Direct the computer to the location of the file in the Data Source Manager Window that appears. We do this

by clicking the Browse button | *** I to the right of the Source field:

(! Data Source Manager | Vector
Source Type
® File | Directory | ' Database Protocol: HTTP(S), cloud, etc.
Encoding System

Source

Vector Dataset(s)

Close. Add

Help

bitude, Longitude’ ECIENICIN
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Direct the computer to your QGIS folder > Data > GSI_Bedrock_500k and select the file BED500K.shp. Make
sure you choose to open the file which is type SHP File (shapefile):

Q Open OGR Supported Vector Dataset(s) X
«— v T > OneDrive > Desktop » QGIS-FS » Data > GSI_Bedrock_500k v O Search GSI_Bedrock_500k »
Organise ~ New folder =+ M @

Images ~ Name Date modified Type Size -~
My Course [ so0kbed.style 11/08/2020 12:08 STYLE File 736 KB
NUIG-QgisCours [] BED500K.dbf 11/08/2020 12:08 DBF File 36 KB
Surveys [] BED500K.prj 11/08/2020 12:08 PRI File 1KB
A I B F
& CreDrive [] BED500K.sbn 11/08/2020 12:08 SBN File 1KB
etachment [} BEDS00K sbx 11/08/2020 12:08 SBX File 1KB
achments
|| [ BED500K shp 11/08/2020 12:08 SHPFile 6,997 KB
Deskt
L EE=5SE T T BED500Kshp TT/08/7070 1208 YR Documant 57RE
£ Documents [ BED500Kshx 11/08/2020 12:08 SHX File 1KB
=] Pictures 1 Digital Licence Agreement 11/08/2020 12:08 Microsoft Word 97... 44 KB
W This PC [] Dykes500k.dbf 11/08/2020 12:08 DBF File 1KB
Dykes500k.prj 11/08/2020 12:08 PRIF 1KB
¥ 3D Objects L DykesS00kp1 e ¢
o Dok [] Dykes500ksbn 11/08/2020 12:08 SBN File 2KB
ESKILO|
- P [] Dykes500ksbx 11/08/2020 12:08 SBX File 1KB
& Documents [} Dykes500kshp 11/08/2020 12:08 SHP File 14 KB
¥ Dowinloads [7] Dykess500kshp 11/08/2020 12:08 XML Document 20KB
b Music [7] Dykes500kshx 11/08/2020 12:08 SHX File 1KB
=] Pictures [ Faults500k dbf 11/08/2020 12:08 DBF File 748 KB
& Videos [ Faults500k.prj 11/08/2020 12:08 PRI File 1KB
£ Windows (C) [ Faults500k.sbn 11/08/2020 12:08 SBN File 59 KB
v [ Faults500ksbx 11/08/2020 12:08 SBX File 4KB v
File name: |BEDS00K shp v| [ anfiles v

Back in the Data Source Manager Window press Add and then Close.

The geology layer appears with many polygons all the same colour. Shapefiles have coordinate reference
systems in order to place them accurately geographically. As our workspace was empty prior to adding this
shapefile it automatically converted the workspace to its coordinate reference system, readable at the bottom
panel as the code 29902:

Coordinate| 522507,240207 | Scale|1:2876201 = | @ Magnifier| 100% %| Rotation | 0.0 ® 2 /| Render |®EPSG;29902| [---]

5. Click on the code 29902. This brings up a window that informs us that we are working in the
Coordinate Reference System of the Irish Grid:
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() Project Properties | CRS K
N

Project Coordinate Reference System (CRS)
No projection (or unknown/non-Earth projection)
Filter | =

Recently used coordinate reference systems

) Coordinate Reference System Authority ID =
¥ Default Styles TM6S5 / Irish National Grid EPSG:29900
E Data Sources IRENET95 / Irish Transverse Mercator EPS5G:2157
WGS 84 / Pseudo-Mercator EPSG:3857 -
EE Relations 4 k
Coordi fi ce systems of the world Hide deprecated CRSs
Variables
Coordinate Reference System Authority ID =
{;-.@ Macros TGD2005 / Tonga Map Grid EPSG:5887
I QGis Server TMB65 / Irish Grid EPSG:29902
4 »
TM65 / Trish Grid - - \

WKT
PROJCRS["TM&S / Irish Grid",
BASEGECDCRS ["TMes™,
DATIMI"TMES™.

w Datum Transformations

V| Ask for datum transformation if several are available (defined in global setting)

Irish Grid is the older version of the Irish Transverse Mercator. Close this window without making any changes.

6. Looking at this map we cannot distinguish any differences visually between places with different
geology. To change this, we tell QGIS to make the symbology categorised.

Right-click on the geology layer and choose Properties. Within Symbology Categorising symbology
change 'single symbol' to 'Categorized":

(.} Layer Properties - BED500K | Sy

Mo symbols
== .
= S5ingle symbol
Graduated
JHQ. L S
g B (= Rule-based
Inverted polygons

"'i' Information

I I|ﬂ

2.5 D

Unit Millimeters

Now we assign the value to base the categorisation on (this information is included in the Attribute Table).
Click on Value and choose UnitName in the drop-down list:

.
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| :— Categorized

e .
2 Informat

:'{:\1_- Source

Value |

Symbol

Labels
Diagrams
3D View

Fields

123 natmapcode
123 unit_label

Color ramp

E

Symboal
—|abc AgeBracket

abc unit_table
1.2 Area_km2

abc Formation

UnitName

String (254)

Finally, click on classify to tell QGIS to assign a colour for every Unit Name.

Q Layer Properties - BED500K | Symbology

P - .
f2 ' Information

‘}&,\ Source

" Symbalogy

€an Labels

o Diagrams

W# 3D View

E Fields

E Attributes Form
Joins

ﬁ Auxiliary Storage

Q Actions

’ Display

4 Rendering

Variables

H. Metadata

M’ Dependencies
Legend

&8 qGls Server

H Digitizing

Grounded - Explore your world

X
| = categorized - |
Value  abe Unithame - | \E\
T
Color ramp | Random colors |§\
Symbol ~ Value Legend
| Classify ||E\ [= ] oelete an | Advanced ~ |
» Layer Réndering
| syle | o< || concel | Apply || mep |
0\.,
>9 e S
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You should now see a list that looks something like this (your colours will vary):

(2} Layer Properties - BED500K | Symbology X

| E Categorized

(z' Information Value |=hc UnitName

[ .,

‘ Symbology Color ramp | Random colors

L abc) Symbol ~ Value Legend =
1, Meta... 1, Meta-dolerite, meta-gabbro

10, Rhy... 10, Rhyolite

11, Dol... 11, Dolerite & gabbro

12, Rhi.. 12, Rhinns Complex (Inishtrahull); Syenitic orthogneiss, minor metagabbro
13, Mul.. 13, Mullet Gneiss; Granitic orthogneiss

14, Cro... 14, Cross Point Gneiss; Granitic orthogneiss

15, Do... 15, Doolough Gneiss & Granite; Granitic orthogneiss & granite

16, Kil... 16, Kilmore Quay Group; Paragneiss, schist

17, Gre... 17, Greenore Point Group; Schistose amphibolite

18, Tyr... 18, Tyrone Central Inlier; Quartzo-feldspathic paragneiss & schist

19, sSlis... 19, Slishwood Division; Quartzo-feldspathic paragneiss

2, Serp... 2, Serpentinite, Neoproterozoic (NE Ox Mts) & Lower Ordovician (Clew Bay, Carnew)
20, Inis... 20, Inishkea Division (possibly Dalradian); Psammitic & pelitic schist

21, Gra... 21, Grampian Group; Psammitic & pelitic schist

22, Ap... 22, Appin Group; Quartzite

23, Ap... 23, Appin Group; Psammitic & pelitic schist & marble

24, Arg... 24, Argyll Group; Paragneiss & migmatite

25, Arg... 25, Argyll Group; Amphibolite & amphibolitic schist

26, Arg... 26, Argyll Group; Quartzite

27, Arg... 27, Argyll Group; Psammitic & pelitic schist, marble, amphibolite, diamictite
28, Sou... 28, Southern Highland Group; (Epidote-Jamphibolitic schist & tuff

29, Sou... 29, Southern Highland Group; Pelitic & psammitic schist, phyllite & marble
3, Orth... 3, Orthogneiss suite, mainly quartz diorite (Connemara)

30, Mar... 30, Marine; Quartzite & minor slate

31, Mar... 31, Marine; Slate

27 mar 22 Marina: Grawnnacka & chala

Classify HE‘
P Layer Rendering

<
|

-
1

W7 3D View
Fields

E Attributes Form
Joins

ﬁ Auxiliary Storage

@ Actions

, Display

g Rendering

& Metadata

ﬁ Dependencies
Legend
&8 qGls Server

B Digit

/R RR[R&&&
i) misis] ] el ] Jeeiee] ] e

-

EH Delete All ‘ |ﬁdvanced "

| Style " oK H Cancel H Apply H Help ‘

Click Apply and colours will be applied to your geology map:

| *Environmental-Report - QGIS - X
Project Edit View Layer Settings Plugins Vector Raster Web Mesh Processing Help

DEARRH UL APP A/ RBLERS Q6 -N-E-,HE#I&-° 0
x4 N =Qqq= QAR 2a

'
Browser EL)
LIEEREX)
@ Favorites =
» " Spatial Bookmarks
Va | G Home
VARRSE:Y
" @ GeoPackage
“| /2 spatialite
2} @ rosiGis
P mssaL
@ Oracle
@ oB2
@ WMs/WMTS
- @ X¥Z Tiles
=" OpenStreetMap
@ wes
@ wrs
© ows
Layers L]
“A®RTE&E-BRO
» |9 BEDS00K

Q Type to locate (Ctrl+K) Coordinate| 219696,181880 | Scale|1:2814836 ¥ | @ Magnifier| 100% 2| Rotation [0.0° 3| Vi Render @ epsci2oonz @

7. How do we know what geology is at the Cliffs of Moher Centre? We need to zoom in to the correct
location. Using the Quick Map Services we will zoom in to County Clare coastline and try to find the

Centre.
~L
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T
Click the Quick Map Services Icon, o and choose Google Road:

L5l Geofabrik b
m Google Hybrid
& Kosmaosnimki.ru » a Google Labels
@ Portugal d .
a m Landsat 4 PA’ Google Satellite
'R‘-‘ MapSurfer NET 4 VA’ Google Terrain
@ Mapbox » | Z¥ Google Traffic
@ nNAsA » | Z¥ Google.cn Normal
“ Georgia » PA’ Google.cn Satellite
4 cowonn N

Remember to turn off the bedrock layer so that you can see the map if it is lying underneath:

Layers @®
¢ J o T &~-FB AL
BED500K 1

~ |v| = Google Road

Can you find the Cliffs of Moher Centre? It might take you a while. It is north of Lahinch and South of Doolin:

RATT :
Lisdoonvarna
Doolin [Ra78]
Doolin
HU\\duy
Cottages
D(J[)rmgur(-} Y
Ra78
Lough North
RaTE
Kilshanny
Cliffs of Moaw@ 8 e
)
s |
S1 Brigid's
Well Cahilly g
Liscannor Ennistimon
e
Lahinch
 Nes)

8. Turn the geology layer on again and make the symbology of the layer 50% transparent in order to see
locations beneath. Right-click > Properties > Layer Rendering and set it to 50%:

0
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Q Layer Properties - BED500K | Symbology

",i Information
'J-&W_- Source
‘ Symbology

€3 Labels Symbol

X
E Categorized - |
Value ‘ahc UnitName - ‘ |§|
Symbol ‘ |:|
Color ramp ‘ Random colors El
-

¥ Value

v

-

g Diagrams

\" 3D View
B rieios

E Attributes Form

Joins

ﬁ Aux

ry Storage
@ Actions
- Display

&, ‘ Rendering

el alald L LAl

VEUELE

48, Transgression - regression sequence (Killary Hbr - Joyces Country Succ.); Sandstone, conglomerate, greywacke, mudst
49, Deep marine turbidite sequence; Mudstone, greywacke & conglomerate

5, Gabbro, dolerite & diorite

50, Basalt, andesite, basaltic & andesitic tuff

51, Rhyolite & rhyolitic tuff

52, Continental redbed facies; Sandstone, siltstone & mudstone (base of Dingle Group is in the Upper Silurian)
53, Continental redbed facies; Sandstone, siltstone & mudstone

54, Continental redbed facies; Sandstone, conglomerate & siltstone (in places extends into the Carboniferous)
55, Shallow marine, (Cork Group, Old Head Sandstone Fm); Sandstone & mudstone

56, Basalt, trachyte, syenite & tuff

57, Marine (Cork Group) (extends into the Visean); Mudstone, sandstone & thin limestone

58, Shallow marine ("Lower Limestone Shale™); Shale, sandstone & thin limestone

59, Shallow marine & coastal plain (basal clastics); Sandstone, mudstone & conglomerate

6, Microgranite & porphyry

60, Shallow & marginal marine (Navan Group); Dark-grey limestone, mudstone, sandstone, minor evapaorite
61, Marine shelf & ramp facies; Argillaceous dark-grey bioclastic limestone, subsidiary shale

»

| Classify HE| ‘EH Delete All

| Advanced ¥ |

&~ Metadata

Depende
Opacity
Legend

} ETECEE
Layer Feature
B ‘Normal hd ||Norma| hd ‘
Draw effects
Control feature rendering order
| Style 'l ‘ oK H Cancel HI Apply I\ll Help |

9.

the Tool Bar, &

To find out the geology select the layer in your Layers Panel and select the Identify Features tool from

[ Using Identify Features tool

Click on the bedrock polygon overlaying the location of the Cliffs of Moher and the identification results will

show the geology as 'Namurian sandstone, shale':

-

CE-LEESE Y=

o LT
QOR ~a B
T T Hallyvaughan Iaentify Results
H #RH 58 LR g
@ Afllwee Cave Feature Value

71, Fluvio-deltaic & basinal marine {Turbidi|

o=

Deelin 71, Fluvio-deltaic & basinal marine {Turbidi
580
il
Palaeozoic, Carboniferous, Pennsylvanian
unit_tables\unit_71.xls
5525.33154999999988

| Namurian sandstone, shale |

Meggagh Carran

Burren National Park

Killinaboy

Close the results panel by clicking on the small x:

Grounded - Explore your world

62

U
Y d
Science S I
Foundation

Ireland For what's next



UscrooL

Identify Results @
5 BHR G e N

&

Feature Value
* B..

w

71, Fluvio-deltaic & basinal marine (Turbiditic); Shale, sandstone, siltstone & coal

71, Fluvio-deltaic & basinal marine (Turbiditic); Shale, sandstone, siltstone & coal
580

71

Palaeozoic, Carboniferous, Pennsylvanian
unit_tables\unit_71.xls
5525.33154995999988

Mamurian sandstone, shale

Click on the Pan Map tool, @ , to stop identifying features.

You can now answer the Task question about geology for the Environmental Report.

10. Now we will add the aquifer information. Firstly, download the aquifer data from:

https://cutt.ly/njUXuvi (called GSI_Groundwater_Bedrock_Aquifers). Save this zipped file into the
'‘Data’ subfolder within your QGIS folder.

€ Savehis x
« v > ThisPC » Desktop * QGIS-FS » Data w Q 2 Search Data
Organize * New folder SEE 9

~ Mame Date modified Type
# Quick access

I Deskt P 5 GSI_Bedrock_500k 16/01/2021 17:34 Compressed (zipp... 4,562
esktop

* Downloads
@ Documents

| Pirtures o ¥ [£

File name: | GSI_Groundwater_Bedrock_Aquifers

Save as type: | Compressed (zipped) Folder

. Hide Folders Cancel
11. Right-click the folder and select 'Extract All'. A folder will be created that has all of the unzipped files
in it:
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https://cutt.ly/njUXuvi

g Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:

C:h\Users\ Fionat Deslktopt QGI5-F5\Data\G5l_Groundwater_Bedrock_Aquifers

Browsze...

Show extracted files when complete

12. Return to QGIS and add the aquifer data to your workspace by clicking Layer > Add Layer > Add

Vector Layer:

Ental-R

View

Y

SE

T & ¢

Favaorites
Bpatial B
Project H
Home

[\

- QGIS

(EVE | Settings  Plugins Vector Raster Web Mesh Processing Help

mata Source Manager Ctrl+L
Create Layer

Add Layer

Embed Layers and Groups...

Add from Layer Definition File...

Copy Style

Paste Style

Copy Layer

Paste Layer/Group

Open Attribute Table Fo

Toggle Editing

B YA

.y Add Vector Layer...
':; Add Raster Layer...
B4 Add Mesh Layer..

B, Add PostGIS Layers...
;75 Add Spatialite Layer...

[, Add DB2 Spatial Layer...

9., Add Delimited Text Layer...

P Add MSSQL Spatial Layer...

@, Add Oracle Spatial Layer...

Ctrl+Shift+V
Ctrl+5Shift+R

Ctrl+Shift+T
Ctrl+5hift+D
Ctrl+Shift+L

Ctrl+5hift+2
Ctrl+5hift+0

Direct the computer to the location of the file in the Data Source Manager Window by clicking the Browse

button
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Direct the computer to your QGIS folder > Data > GSI_Groundwater_Bedrock_Aquifers and select the file
IRL_AQUIFER_BEDROCK_ITM.shp:

(2} Open OGR Supported Vector Dataset(s) X

« v 4 » ThisPC » Desktop » QGIS-FS » Data » GS_Groundwater_Bedrock_Aquifers v O O Search GS|_Groundwater_Be...

Organize = MNew folder f=~ M @

Cu MName - Date modified Type Size
;Q;::::ESS H AQUIFER BEDROCK.style STYLE File 584 KB
< AgquiferBedrock QGIS Layer Settings 1T KB
‘f Downloads [ Bedrock Aquifer Faults.lyr L'YR File 17KB
=] Documents [7] Bedrock Aquifer.yr LYR File 17KB
=] Pictures [| GROUNDWATER.IRL_AQUIFER_BEDROCK_FAULT_ITM.lync LYRX File 12KB
Camtasia-vids |J GROUNDWATER.IRL_ACQUIFER_BEDROCK_ITM.Iyrx LYRX File 26 KB
Grounded |_'| GSI_Licence_CC_BY_40 Text Document 1TKB
logos |_'| IRL_AQUIFER_BEDROCK_FAULT_MM.cpg CPG File 1KB
My Course |_'| IRL_AQUIFER_BEDROCK_FAULT_ITM.dbf DEBF File 4102 KB
| | IRL_AQUIFER_BEDROCK_FAULT_ITM.prj PRI File TKB
& Creative Cloud Fil |_'| IRL_AQUIFER_BEDROCK_FAULT_ITM.sbn SBM File 146 KB
[ IRL_AQUIFER_ BEDROCK_FAULT ITM.shx SBX File S KB
@ OneDrive |_'| IRL_AQUIFER_BEDROCK_FAULT_ITM.shp /2021 17:11 SHP File 3,267 KB
3 This PC =) IRL_AQUIFER_BEDROCK_FAULT_ITM.chp 20211711 XML Document 31 KB
“J 3D Objects |_'| IRL_ACQUIFER_BEDROCK_FAULT_ITM.shx 17/01/2021 1711 SHX File 123 KB
I Desktop |J IRL_AQUIFER_BEDROCK ITM.cpg /2021 1711 CPG File 1KB
|‘:5'| Docurments |_'| IRL_AQUIFER_BEDROCE_ITM.dbf 172021 17:11 DEF File 23402 KB
|| IRL_AQUIFER_BEDROCK_ITM.prj PRI File TKB
¥ Downloads [ IRL_AQUIFER_BEDROCK_ITM.sbn SBN File 246 KB
' Music [ IRL_AQUIFER_BEDROCK_ITM.sbx SBX File 15 KB
& Pictures | LT IRL_AQUIFER_BEDROCK_ITM.shp SHP File 43,189 KB
m Videos = IRL_ACQUIFER_BEDROCK_ITM.shp / XML Document 50 KB
i, Local Disk (C:) [ IRL_AQUIFER_BEDROCK ITM.shx 17/01/2021 17:11 SHX File 200 KB
& e
File name: ||RL_AQUIFER_EEDROCK_ITM‘shp v| Al files v
Cancel

Back in the Data Source Manager Window press Add and then Close.

Just like the geology data, the aquifer layer appears with many polygons all the same colour. Looking at this
map we cannot distinguish any differences visually between places with different aquifer .

pw . istingui y' |' Vi u' y w. .p with di 'qm Lerdin A s
type. However, instead of classifying the layer (like we did with the geology) we will load a

Style that came packaged with the aquifer data.

13. Right click the aquifer layer and select Properties. Within Symbology click Style and Load Style:
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() Layer Properties - IRL_AQUIFER_BEDROCK_ITM | Symbology

= Single symbol

.’i ~ [ Fin

B simplefill

Information

JA‘- Source

‘ Symbology

€1 Labels

Diagrams Unit | Millmeters - |
Opadity 1 100.0 % 2|
Color | |'|
Fields
Attributes Form
Q. All Symbols a|-|
iary Storage
}:I‘Ctl - -‘ ! - - -
Ty gradient gradient grayfill gradient bluefill  gradient brown  gradient green  gradient arange
plasma fill fill fill
Rendering
Variables
Save Style...
[EELELE] Save as Default
Restore Default ple  gradient red fill  gradient yellow gray 1fill gray 2 fill
Dependencies fill
Add... | save symbel... | | Advanced ~|
Legend Renarne Current...
e defoult
CQGIS Server I
| | ok || Cancel || Apply || hep |

(2} Database Styles Manager X
Load style | from file = |

v "5-@ Layer Configuration =

' {3’ Symboelogy

v @ 3D Symbelogy
Categories V| (abe | abels

V| [ 5| Fields

v . Forms

=

L' é@'} Actions

File
Load Style | Cancel | | Help |
~&
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Select the file style layer AquiferBedrock within your GSI_Groundwater_Bedrock_Aquifers folder and press

Open:

() Select a file *
« v s « OGIS-FS » Data » |GSI_Groundwater_Bedrock_Aquifers v & D Search GSI_Groundwater_Be...
Organize « Mew folder = W @

) Marme - Date modified Type Size
7 Quick access
- Desktop < AquiferBedrock 17/01/2021 17:11 QGIS Layer Settings
& Downloads
|=| Documents wl= 5
File name: | AquiferBedrock V| QGIS Layer Style File, SLD File (* ~
Press Load Style:

(2} Database Styles Manager >

Load style from file -
.I_: - . - .
v g Layer Configuration
v &% Symbology
v @ 3D Symbology
Categories V) fabe Labels
v! [ 5| Fields
v Forms
v !“E Actions
-

File ktop\QGISF5\DatalGs] Groundwater Bedrock AguifershagquiferBedrodk. gmi

| LoadStyle | Cancel Help

.
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Your Layer Properties symbology should show a list that looks like this:

() Layer Properties - IRL_AQUIFER_BEDROCK_ITM | Symbology *
= Categorized . J
Information Valug |=|ﬂ= AQUIFERCAT |,‘ =
2 Source
‘ Symbology
Symbol ™ Value Legend
€I Labels [] Lake Lake
Lk Lk
Diagrams LI LI
Lm Lm
P 3 Pl Pl
Pu Pu
E Fields Rf Rf
Rk Rk
E Attributes Form Rkc Rkc
Rkd Rkd
® | Gty || ||=]| pdeteal | Advanced_-
@ SHans p Layer Rendering
9 oiriey e~ o [ o | my || e

14. Make sure the geology layer is turned off and make the symbology of the aquifer layer 50%
transparent in order to see locations beneath. Right-click > Properties > Layer Rendering and set it to
50%.

15. To find out the aquifer type at the Centre select the layer in the Layers Panel and select the Identify

Features tool, E%

)
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Click on the aquifer polygon overlaying the location of the Cliffs of Moher Centre and the identification results
will show the aquifer as category LI - a 'Locally Important Aquifer":

Gres T8 VECTOT tanre
Kilkeady, > i GDAL
e filfenar=") laam | reh Identify Results )
Killnatey S BEH R %0 e ey
Corofin . Feature Value
S ean RUGCHAMGES  NULL
AQUIFERCAT LI
ACUIFERTYP MULL
AQCATORIG MULL
s CKCOMMENTS  MULL
GWLAKE MULL
o TYPE MULL
7k NAME NULL
LAKE_ 0
Clarecastie Quir LAKE_ID 0
FID_LAKE -1
Laiocn PERIMETER. 0
PAR_MAT MULL
COUNTY MULL
POLY_ID 0
Deonbeq ABEL KM SO, 793 00753775
ACQUIFER_DE h

Close the results panel by clicking on the small x:

Click on the Pan Map tool, Y{ZI , to stop identifying features.
You can now answer the Task question about aquifer category for the Environmental Report.

16. Next we want to answer the final question, how far is the site from the nearest river? Before we do
this, let's create a point on the map to indicate the location of the site. This is useful for consistent
measurements and also means that we don't have to drag the map around, zooming in and out every
time to find the site. To do this we can add a point using geographic coordinates of a place.

Open Excel and prepare a table containing the following fields: Unique ID,

Add point using CSV file
Feature Name, Latitude, and Longitude:

AutoSave (@ oOff)

File Home Insert Page Layout Formulas Dat

Ifr] & Cut

Paste EB Copy ~
~ @ Format Painter

Calibri

I U~

Clipboard (%1 Font
F17 - e

A . B L C | D L E
_|Unique ID Feature Name Latitude Longitude l

We will input the coordinates for the Cliffs of Moher Centre into their respective Latitude and Longitude cells.
QGIS requires that these coordinates are in decimal degree format. To find them we can use Google Maps.

17. Go on to your internet browser (e.g. Google Chrome, Internet Explorer) and in Google Maps search
for the Cliffs of Moher Visitor Centre. On the map right click at the centre and copy the coordinates:

L
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Insert the coordinates into their respective cells in Excel and input the other text as shown.

UscrooL

Cliffs of Maoh
@t"ﬁliffg nf Mnhar

52.97241,-9.43110 @
Directions from here
Directions to here
What's here?

Search nearby

Print

Add a missing place
Add your business
Report a data problem

Measure distance

ila
lor

Note, your

decimal degrees are probably slightly different to what is shown below. The coordinates depend on where

your mouse clicked on the map (a difference of metres):

v w2

A

B C D

Unique ID Feature Name Latitude Longitude
1 Cliffs of Moher Centre  52.972014 -9.426352

18. Save this table in your Data folder, call the file Centre-Location and make sure to specify the file type

as Comma Separated Values format (CSV):
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E' Save As
« v 1 » ThisPC » Desktop » [QGIS-FS » Data »
Organise = New folder
A ~
& This PC Name
_J 3D Objects GSI_Bedrock_500k
[ Desktop GSI_Groundwater_Bedrock_Aguifers
Documents GSI_Groundwater_Vulnerability
¥ Downloads
J‘ Music
[&] Pictures

E Videos

v O

Date modified

11/08/2020 12:08
11/08/2020 1532
11/08/2020 1556

Search Data

Type

File folder

File folder

File folder

% Windows (C) v L 3
File name: | Centre-Location —
Save as type: | Excel Workbook e

Excel Workbook

Excel Macro-Enabled Workbook
Excel Binary Workbook

Excel 97-2003 Workbook

Authors:

AWML Data
Single File Web Page
Web Page

Cornl T ot

» Hide Folders

19. Close Excel and go back to your QGIS project.

20. From the Layer Menu option select Add Layer and Add Delimited Text Layer:

(2 *Environmental-Report - QGIS

Project Edit View Settings Plugins Vector Raster

Web Mesh Processing Help

(! Data Source Manager Ctri+L

=
[ i |
f Create Layer
= Embed Layers and Groups...
Browser Add from Layer Definition File...

= - [ Copy Style

= = Favorite Docs

[P

P

LN E @

BR-B-LEE

ai, Add Mesh Layer...
+ Add Delimited Text Layer...

W A DAc+ICl auar

i i FS a2
7, Add Vector Layer... Ctrl+Shift+V
B, Add Raster Layer... Ctrl+Shift+R

Ctrl+Shift+T

Ciel o Shifta [

(1

]

Click on the Browse button,

, to direct the computer to your CSV file 'Centre-Location' and open:

(X Data Source Manager | Delimited Text
[ Browser

- g Vector

File name.
Layer name

s Raster w File Format

®) sV (comma separated values)

Regular expression delimiter

$H4 Geopackage

Custom delimiters

7, Spatialite » Record and Fields Options

+ Postgresal w Geometry Definition

s MssaL @) Point coordinates X field

Well known text (VKT) ¥ field

Oracle

v | Zfield

v | Mfield

Encoding |UTF-8

x

;‘, Browse

sandsto

sandstol
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» This PC » Desktop > QGIS-FS > Data > + 0
ew folder
~ MName Date modified Type

* GSI_Bedrock_500k 11/08/2020 12:08 File folder
» GSI_Groundwater_Bedrock_Aguifers 11/08/2020 15:32 File folder

GSl Groundwater Vulnerability 11/08/2020 15:56 File folder
ol Centre-Location 12/08/2020 17:04 Microsoft Excel Co...
»

17/04/2020 19:46
11/08/2020 16:10

T GSI_Bedrock_500k Compressed (zipp...

z INSM250k_ING_1b Compressed (Zipp...

Lours

File name: |Centre-Location

Search Data

Size

1KB

4,562 KB
93,433 KB

v| Al fites

Cancel

The Data Source Manager window should look like the following:

Q Data Source Manager | Delimited Text

B Browser

- ¢ Vector

File name | C:\Users\fiona\OneDrive\Desktop\QGIS-FS\Data\Centre-Location.csv

Layer name | Centre-Location

w File Format

®) CSV (comma separated values)

Regular expression delimiter

 Raster
v 5
2 Mesh
, Delimited Text

55

) GeoPackage ) Custom delimiters

# Spatialite » Record and Fields Options

+ PostgreSQL w Geometry Definition

« MSsaL ®) Foint coordinates X field | Longitude

¥ field | Latitude

4 Oracle Well known text (WKT)

| No geometry (attribute only table) DMS coordinates
082, pa2

Geometry CRS EPSG:4326 - WGS 84

m Virtual Layer
P Layer Settings

& wMs/wMTS

Sample Data
£ wes
- Unigue ID Feature Name Latitude  Longitude
w WS 11 Cliffs of Moher Centre 52.072014 -9.426352

ArcGIS Map Server

ArcGIS Feature Server

v | Zfield

¥ | M field

e Layer name - the name of the CSV will show up here.
e File format - CSV
e Geometry definition - "Point coordinates" option; X Field — Longitude; Y Field - Latitude

e Layer settings - you will see a preview of the table.

Select Add and then Close.
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A dot will now be present on your map, showing the location of the Cliffs of Moher Centre, and a new layer is

shown in the Layers panel:

o @l & T &~-F T 0

Layers & &l

| v @ Centre-Location |
» v [~ BED500K

~ /| i Google Road

- = Google Satellite

21. We always save CSV features as shapefiles to allow for future editability in QGIS. Right click the layer >

Export > Save Features As:

[ Exporting shapefile from CSV ]

Browser Fatnral B
®oecrroe
@ ¢ Favorit 52 Zoom to Layer
Ve v " Spatial - Zoom to Selection
Q -
f » [¥ Project 99 show in Overview
» [&] Home
8
Show Feature Count
lﬁ 3 |:| CA\
» e GeoPa Copy Layer
l"* f Spatial Rename Layer
@ rostGls i
Duplicate Layer
P mssal L owp Y
@ Oracle ﬂ, Remove Layer...
5 DB2 Open Attribute Table
@ WMSA i,
- &P XyZTil
= Op Change Data Source...
@ WCS Set Layer Scale Visibility...
WFS Set CRS
OWSs
= Export Save Features As...
Layers Styles » Save Selected Features As...
¢ 4 =7 2] Save as Layer Definition File...
v = = LOCatlD Oliffs of i
! Save as QGIS Layer Style File...
b v O~ BED500K oy
- /| & Google Road
- = Google Satellite
In the File Name box of the Save Vector Layer dialog use the Browse button, | i |, to indicate where the

shapefile should be saved:
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@ Save Vector Layer as... %
Format | ESRI Shapefile =
File name [ ] 1
Layer name | Browse
CRS | EPSG:4326 - WGS 84 - ‘ |§|
|A
Encoding |System v |

D Save only selected features
b Select fields to export and their export options

w Geometry

Direct the computer to your Shapefiles folder and call it 'Centre-location’, type ESRI Shapefile, and press Save:

Q Save Vector Layer as...

Format  ESRI Shapefile

File name ‘

Layer name ‘

CRS ‘ EPSG:4326 - WGS 84
Q Save Layer As

Encoding « v 4 «| QGIS-FS > Shapefiles v U Search Shapefiles

D Save only selected features

Organise ¥ New folder
P Select fields to export and their ¢

v Geometry I Desktop A~ Name Date modified
¥ Downloads o
Documents o
[&] Pictures 4

Data i S

Geometry type Mo items match your search.

D Force multi-type

D Include z-dimension

b || Extent (current: layer)
¥ Layer Options

File name:l Centre-location

Save as type:IESRI Shapefile (*shp *SHP)
L

RESIZE | NO

1 ~ Hide Folders

SHPT |

‘w Custom Options

Add saved file to map

Keep all other options as default in the Save Vector Layer As Dialog Box and press Ok.

22. By default the SHP layer will be added on top of the CSV import layer with the same layer name. You
can safely remove the CSV layer: right click > Remove Layer.
23. Now that we have our consistent and accurate location, let's find the nearest river.

Zoom in and spot the rivers as the thin blue lines, shown below in the red boxes:
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Cah erbarna

SANDFIELD

]
24. Select the Measure tool, o

Measure distance

Click on the site location and click on the closest point of the nearest river. You can read the distance in the
Total box of the Measure window. Please Close when you're satisfied with your answer:

arks

Cartesian @ Ellipsoidal
» Info
Newr Configuration Close
tMap
=]

E = P

|ation

ad

tellite

Segments [meters]
2562.542

Total 2562.542 m | meters

Knockevin

0.000

Help

(Ras]

Lislarkin
North

Bally

islane

slarkin
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25. If someone would like to see the line between the site and the nearest river we can add a shapefile to
show this:

Create a polyline
Layer > Create Layer > New Shapefile Layer, choose Geometry type Line.

Specify the CRS as Irish Grid in order to keep it consistent with the workspace:

() New Shapefile Layer X
File name inna\OneDrive\Desktnp\QGIS-FS\ShapeﬂIes
File encoding System v
Geometry type v
Additional dimensions (@ None Z (+ M values) M values
| Project CRS: EPSG:29902 - TM65 / Trish Grid > Il

New Field

Name

Type | abc Text data -

Length |80 Precision

Add to Fields List

Fields List
Name Type Length Precision
id Integer 10

Remove Field

| OK | Cancel Help

26. To create the line, right-click the river layer in the Layers Panel and turn on Toggle Editing.

Layers =]ES]
S VR 0 )

/| @ Centre-location
0/ Contremiver |
> (= BED500K
* | =" Google Road
v = Google Satellite

27. Now select the Add Line Feature icon, ¥,

( *Environmental-Report - QGIS
Project Edit View Layer Settings Plugins Vector Raster

I EBREY (2L 2P
2.7 [ - B
. _|Add Line Feature % pa
‘o~ B (Ctrl+) S & g 3

~n =

Science
Foundation
Ireland For what's next

.
Grounded - Explore your world 76 O‘gﬁ



UscrooL

Draw your line between the centre and the river and right-click to close it. Save your edits and turn off Toggle
Editing.

28. Find the length of this line by selecting Vector from the Menu > Geometry Tools > Add Geometry
Attributes. . . .
. ribu 'es . _ Calculating distance of polyline
29. Right-click the resulting scratch layer (‘added geom info') and
open the Attribute Table to see the calculated length of the line. It will be something close to the
rough measurement you did before with the mapping ruler tool.

30. Save this file to make it permanent, you can call it Centre-River-d02:

Right click > Make Permanent (or you can use Export Save Features As)

Layers (& (]
o il ® T & ~& & O
v @ C(Centre-Location

Added geom info _—

) Zoom to Layer

v'| — Centre-River #
v |v| 9 IRL_LAQUIFER_BEDROCK_| ~ Z£oom to Selection
v = BEDS00K @2 Show in Overview

~ || B Google Road Show Feature Count

Copy Layer
Rename Layer

L] Duplicate Layer

[l Remove Layer...
Mawve to Top

| Open Attribute Table

4 Toggle Editing
Eilter...
Change Data Source...

Set Layer Scale Visibility...

Set CRS b
Export v
Styles b
Properties...

Browse to Shapefiles folder in the Save Scratch Layer window:

e
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Format ESRI Shapefile
File name

Layer name

TET

(2} Save Layer As

s

« v <« (GIS-F5 3| Shapefiles Search Shapefiles
Organize * Mew folder == - 0
_J 30 Objects G MName Date modified Type )
I5] Desktop [ Centre-Location.shp 11/12/2020 19:50 SHP File
| Documents |_'| Centre-Location-1G.shp 22/12/2020 17:06 SHP File
; Downloads |_'| Centre-River.shp 11/12/2020 19:55 SHP File  w
K hauici- i RS &
Tl Centre-River-d02.shp V]
Save as type: | ESRI Shapefile (*.shp *.5HP) ~
~ Hide Folders Cancel

el

OK

Cancel

Help

Press Ok in Save Scratch Layer window.

31. Well done, you answered all the task questions. Before you go you should zoom in to the location of

your house or school and find out the geology, aquifer category and how close the nearest river is,

using the skills you just gained!

Congratulations, now you know how to add data and interrogate it to answer environmental questions about a

location. Don't forget to mark your progress on the Goals Sheet in Appendix A.
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LESSON 5: MAPPING TO PROTECT OUR ENVIRONMENT

LEARNING OUTCOMES:

e Intro to EU conservation Directives
e  Mapping as a tool for protecting habitats
e Intro to open data

BACKGROUND

The Government is under pressure to facilitate development and ensure economic growth in a sustainable
manner. An important part of environmental reporting is consideration of the habitats. One method of
protecting the environment, enforced through European Union Directives, has been to section off areas for
conservation of the habitats and their wildlife. These sites are called SACs - Special Areas of Conservation (for
habitats) and SPAs - Special Protected Areas (for birdlife). These sites are collectively referred to as Natura
2000 sites.

The National Parks & Wildlife Service (NPWS) is responsible for the designation of conservation sites in Ireland.

OPEN DATA:

Open data can be defined as “data that can be freely used, shared and built-on by anyone, anywhere, for any
purpose”?. This type of data stems from external sources around the world. In these instances, data are shared
with an open license, such as the public copyright Creative Commons license.

Open Data enhances collaboration, participation and social innovation. Efficiency can be greatly increased with
cross-sector sharing of data, providing faster access to information.

Attribution requirements: It is possible that the licence states that people who use the data must credit the
owner when they make their product or service available. This is called attribution.

In the following Exercise, the data we are going to use (SACs and SPAs) is open data from the National Parks
and Wildlife Service. We will also be using Google Roads open data.

We will make sure to incorporate the attribution requirements for these data sources on our map.

RESOURCES

e What is open data? https://data.gov.ie/edpelearning/en/modulel/#/id/co-01
e National Parks and Wildlife protected sites information: https://www.npws.ie/protected-sites

e 10 conservation initiatives that have been very successful in delivery of conservation objectives:
https://www.biodiversityireland.ie/biodiversity-irelands-top-10/10-conservation-success-stories/

2Summary of the full Open Definition which the Open Knowledge Foundation created in 2005:
https://opendefinition.org/od/2.1/en/.

—~L
Grounded - Explore your world 79 S Sfl
Foundation
Ireland For what's next


https://data.gov.ie/edpelearning/en/module1/#/id/co-01
https://www.npws.ie/protected-sites
https://www.biodiversityireland.ie/biodiversity-irelands-top-10/10-conservation-success-stories/
https://opendefinition.org/od/2.1/en/

EXERCISE 5: QGIS AND HABITAT MAPPING

Don't forget, all the steps are also demonstrated in the video tutorial, accessible here: https://cutt.ly/9jUZ7bE.
Objective:

e Use GIS to show protected mapped habitats of an area.
Task:

Following on from Exercise 4, the Planning Decision requires the Cliffs of Moher Viewing Platform project to
adhere to EU regulations. This includes ensuring that no Natura 2000 sites are going to be impacted. To show
this we produce habitat maps.

The company are also obligated to inform stakeholders (a person with an interest or concern in something)
about their plans. It is important to involve all stakeholders, particularly the local community, when planning,
designing, and operating tourist attractions so that local knowledge and experience are incorporated. The
company are going to hold a Public Consultation meeting in order to present their vision for the attraction.

You are requested to perform habitat mapping to help form part of the Planning Approval documents and
which will be presented at a Public Consultation workshop, where the company will present their plan for the
attraction to the public.

The Public Consultation Map needs to include the following:

e Location of Proposed Viewing Platform (52.981097, -9.429096)

e Any SACs and SPAs within 2km of the Proposed Viewing Platform
e Location of Cliffs of Moher Centre and the current Viewing Point
e Amaplegend

e The date map was created and the author

e  Map title: 'Habitat Mapping for Public Consultation’

e Attribution of data

Relevant Sustainable Development Goals:

19 tiiwo
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UscHool
Exercise 5 Steps:

1. Reopen the Environmental Project from Exercise 4. Save a copy of it and give the new file the name
'Habitats'.

2. Asthey are not necessary for this mapping exercise, remove the bedrock, aquifer and river layers of
the previous exercise (right click > remove layer). We will keep the Centre-Location layer for now.

3. Firstly, let's add a point to show the Proposed Viewing Platform. Our information tells us this is at the
coordinates 52.981097, -9.429096.

4. Open Excel and input the coordinates into a table, set up like the following:

A B = D
1 |ID Label Latitude Longitude
2 1 Proposed Viewing Platform 529811 -9.4291

5. Save the table as a CSV file:

Save As x
« “ 4 || > ThisPC > Desktop » QGIS-FS » v | o Search Data
Organize + New folder =~ @
Grounded A Name Date modified Type Size
Images GSI_Bedrack_500k 18/01/2021 13:3 File falder
My Course GS|_Groundwater_Bedrock_Aquifers 19/01/2021 15:5 File folder
P8 Microsoft Focel ¥ € 4
File name: | Proposed-Viewing-Platform w
Save as type: TSV (Comma delimited) | iv
Authors:  Fiona Stapleton Tags: Add atag
~ Hide Folders Tools - Cancel
Press Yes to the following:
Microsoft Excel X

o Some features in your workbook might be lost if you save it as C5V (Comma delimited).
Da you want to keep using that format?

Yes Mo Help

Exit Excel.

Note: When you press exit Excel will ask whether you want to save it again, press Don't Save

Microsoft Excel ool

| Want to save your changes to
'Proposed-WViewing-Flatform.csv'?

Save I Don't 5ave I Cancel

O
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6. Add the CSV table to your QGIS workspace:

Layer > Add Layer > Add Delimited Text Layer

£ Settings  Plugins  Vector Raster Database Web Mesh  Processing  Help

\! Data Source Manager Ctrl+L | B
Create Layer 4 }a [E % [E I @Q Lj\
dd W7 Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... .o Add Raster Layer... Ctrl+Shift+R
Add from Layer Definition File... ﬂg Add Mesh Layer...
7 Copy Style « Add Delimited Text Layer... k Ctrl+Shift+T

In the Data Source Manager window browse to the file location.

@ Data Source Manager | Delimited Text

i’ Browser :
File name

. g Vector Layer name Encoding | UTF-8 ¢

4 Raster w File Format

(2 Choose a Delimited Text File to Open X
9 _. Delimited T

I+

4 » ThisPC » Desktop > QGIS-FS »[Data ] v B 2 Search Data
\" -
- eoPackage
f§ GeoPackage Organize Mew folder =~ O @
= -y - -~
# g Spatialite ~  Name Date modified Type Size
7+ Quick access
PostgreSQL B Deskt GSI_Bedrock_300k 18/01/2021 13:37 File folder
+ esktop . . .
G5|_Groundwater_Bedrock_Aquifers 1 2021 15:5 File folder
& MssaL ¥ Downloads  # [@ Proposed-Viewing-Platform 20/01/2021 14:25 Microsoft Excel C... [
| D
ocuments ™ 5
- Oracle
DB2 File name: |Proposed-Viewing-PIatform v| Text files (*.bet *.cov *.dat *whkt) ~
DB2
m Virtual Layer - _ -
1 1 1
rau _ ¥ field - | M field
HE WN M Well known text (WKT)

DMS coordinates
No geometry (attribute only table)  Goometry RS | Project CRS: EPSG:29902 - TM6 ~

P Layer Settings
- ArcGIS Map Server . Sample Data =
:'_ ArcGIS Feature Server Please select an input file

Close Add Help

GeoMode

*

The Geometry Definition updates the X field to Longitude and the Y field to Latitude. The CRS is WGS84.

7. Next, we will convert the CSV point file to a shapefile, so that we can do some processing steps with it
later and to change it from degrees to meters:

Right click > Export > Save Features As

In File name use the browsing button to browse to your shapefiles folder and you can call it Proposed-Viewing-
Platform.

To change from degrees to metres, change the CRS from WGS84 to Irish Grid. This is important for when you
will be creating a buffer around the point, as the buffer will be specified in metres.

e
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(2 Save Vector Layer as... ot
Format ESRI Shapefile -
File name |C:‘n,l_.lsers‘n,Finna‘n,DEskb:|:|\,QGIS—FS\Shapeﬁles\Prnposed—'l.-'ieu\'ing—PlatForm.shp €& |
Layer name
CRS EPS5G:29902 - TM&S [ Irish Grid - —t'i
Encoding LITF-&8 -

Save only selected features
b Select fields to export and their export options

¥ Geometry

Geometry type Automatic =

v | Add saved file to map oK Cancel Help

8. Now let's download the data files for SACs and SPAs: To access the SPA files enter the following link
into your internet browser: https://cutt.ly/UiSI1GO0. To access the SAC files enter the following link
into your internet browser: https://cutt.ly/qjSIZP1

9. Save the zipped files into the 'Data' subfolder within your QGIS folder.

10. Extract the data in the same way that we did it in Exercise 4 (right-click the folder > 'Extract All'). Do
this for both the SAC and SPA files.

11. Now, add the SAC shapefile to your project:

Layer > Add Layer > Add Vector Layer:

Q *Environmental-R - QGIS

Project Edit View|lEVE | Settings Plugins Vector Raster Web Mesh Processing Help

D @ I T Data Source Manager Ctrl+L \B !3 |E| EJ . Eb %%,
Create Layer > R B .
ST R —i = @
Add Layer . » Add Vector Layer... Ctrl+Shift+V |
Embed Layers and Groups... 'u Add Raster Layer... Ctrl+Shift+R
Ty y Add from Layer Definition File... % Add Mesh Layer...
- Ds u = 4
B Copy Style ’u Add Delimited Text Layer... Ctrl+Shift=T
rowser
O & T Paste Style 'j Add PostGIS Layers... Ctrl+Shift+D

.
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When browsing for the correct file, make sure to choose the SHP file format and remember to search for the

file within the Data folder:

m=
bed
Source Type
(®) File () Directory Database (! Protocol: HTTF(S), cloud, etc.
Encoding Automatic - |
Source
* Delimited Text
Vector Dataset(s) -
‘ﬁ GeoPackage E
i‘; Spatialite (2} Open OGR Supported Vector Dataset(s) X
w PostoresQL « v 4 | « QGISFS > Data > SACITM_2019.12.0 > SAC_ITM_2019_12 v O £ Search SACITM_2019_12
MSsQL
* Organize ~ New folder = m @
- Oracle - ~
Documents # " Name Date modified Type Size ~
B82 e SR U EVI . o e e
% D82 [&] Pictures * = -
Wi [0 sacT™M_2019_12.p1 30/08/2020 1413 PR File 168
M Virtual Layer Images N N N
[} SACITM 2019 12:5bn 30/08/2020 1413 SBN File 5KB
& wwspwmts My Course [ SACITM 2019 _12.5bx 30/08/2020 1413 SBX File 1K8
& wes ScreeningStater | [} SAC ITM 2019 12:shp 30/08/2020 1413 SHP File [ 36,079 KB
S Workspaces £] SACITM_2019_12.shp 30/08/2020 1413 XML Document 18K8
i [ sacITM_2019_12:5hx 30/08/2020 1413 SHX File 4K8
I _ ) @ OneDrive
/4 ArcGIS Map Server || sAC_Offshore_WGS84_2015_11.dbf 30/08/2020 14:13 DBF File 2KB
@)ly ArcGIS Feature Sery = This PC v [ sAC_Offshore_WGS84_2015_11.pj 30/08/2020 14113 PRI File 1KB v
s GeoNode File name: | SAC_ITM_2019_125hp ~| Al fites v
b
w
-
Open > Add > Close
Repeat to add the SPA shapefile.
12. Your workspace will now look something like this (your colours will probably differ):
— =
= 7 — ™~ T — - .
BEEY O2LLHPPR Q/  GBLEOR @ -H-5-50E8 % I &)1
5 3 &% i
BQV.Aa® @ / i . ; QaxR 2
2 = - = = =
Browser (2) a®
o mevxe = m
m Favorites E =) LEd
» % spatial Bookmarks
c v [¥ Project Home —
9 |’ ) Home o
e [» O o L
@ GeoPackage e %
f“ /£ Spatialite &
m @ PostGls Dot
B mssaL e
e @ Oracle Paanagort e
2 o2
= B WMSANMTS & -
Layers ® Lovgh Norty
‘S-Q ¥ JeoTV&E-BALO
B V| ® Proposed-Viewing-Platform
2 v [l sPA ITM 2019 12
a Kilshany
v . SAC_ITM_2019_12 o
v @ Centre-Location
~ |v ¥ Google Road
o
e iy
e
8

Note, drag the Proposed Platform Location layer within the Layers Panel to the top, in order to see where it

lies in relation to the SPAs and SACs.
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13. To see what SACs/SPAs lie within 2km of the proposed platform location, we will create a 2km buffer
zone: Create a buffer

Vector > Geoprocessing > Buffer

Specify the input layer as the Proposed Viewing Platform shapefile, and the distance as 2000 metres.

W F:
- Q Buffer bd !
1
Parameters Log Buffer
Input layer i
Y | This algorithm computes a buffer area for all the
7" Centre-Location-IG [EPSG:29902] | ]|D ;gattures in an input layer, using a fixed or dynamic
i istance.

Selected features only
' The segments parameter controls the number of

k Distance line segments to use to approximate a quarter
M drcle when creating rounded offsets.
| 2000} 000000 @ (%] [meters v S
The end cap style parameter controls how line
Segments endings are handled in the buffer.
9 5 = The join style parameter specifies whether round,
miter or beveled joins should be used when @
End cap style offsetting corners in a line.
Round - The miter limit parameter is only applicable for miter

join styles, and controls the maximum distance
from the offset curve to use when creating a
mitered join.

Join style

Round =
Miter limit

2.000000 =
W Dissolve result
M | Buffered
- [Create temporary layer]

V| Open output file after running algorithm

0% Cancel

Run as Batch Process... | Run | Close Help

Press Run and Close

A 2km buffer appears around the Proposed Platform Location, showing that the only SPA or SAC that is within
2km is an SPA.

Note: the buffer is a scratch layer (i.e. temporary) and will be deleted as soon as you exit the QGIS program.
You can make it permanent by exporting as a shapefile.
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Layers
¢ @l ® T &E-FHDO

v | | SPA ITM 2019 12

SAC ITM 2019 12 [l

© Centre-Location-1G

. Buffered t::l
h =" Google Road

14. Use the Identification tool, ﬂtk, to find out which SPA this is. Make sure the SPA layer is highlighted
in the Layers Panel before clicking on the polygon. The results are shown in the panel to the right:

DEREYE VPAPPHPP R BEUR B H-8-%EEME =-7-
QLA E / /B3 x-BE<cBbo ="qq=qu3%% QAR 4 B

Processing Toolbox

240819

@ GeoPackage
Spatialite

@ rostGls

P mssaL

@ Oracle

@ om

B WMSWMTS
5=
B3OV &E-RAL

~ V| ¥ Google Road

Identify Results
2 - AR AN

Festure Naive
~Soa 018 10
v SITE_NAME Cliffs of Moher SPA

This shows that this is the Cliffs of Moher SPA. To stop identifying select the pan tool, @ .

O
Grounded - Explore your world 86 Sd;’:;ﬁ

Ireland For what's next



15. Now we will edit the symbology of the SACs and SPAs. It is useful to follow best practice or find
examples of how other people make their maps. The following example is from the Offaly County
Council Tullamore River Project:

A

Special Areas of
Conservation (SACs)

[D] Special Protection
Areas (SPAs)

—— Watercourses

D County boundaries

Figure 2. Natura 2000 Sites

B Fos o M - s S : T LA =T Tulllamore River Habitat
T . Enhancement

" | Appropriate Assessment
. Screening

River Shannon Callows SAC
2| and
Middle Shannon Calllows SPA | E
; T I N, & B : A scale 1:160,000
ey : 15-10-2019
Rev 0

*Jx_ S :.{‘ — b \ { ! AP 3 _‘n—um-..k-u...

Ordnance Survey Ireland License No. EN 0074219
& Ordnance Survey Ireland / Government of Ireland

They have represented SACs by diagonal red hatching and SPAs by vertical purple hatching. For our map we
will replicate these symbology types.

[ Editing symbology J

16. Right-click the SACs layer and select Properties. In the Properties window select Symbology and click
on Simple Fill:

(2} Layer Properties - SAC_ITM_2019_12 | Symbology x
:- Single symbaol - |
(%) Information ~ [ Fill |¥|
':-'u::- Source —
3][a]
Labels
Diagrams
3D View Symbal layer type{ Simple fill - |
Fields Fill color | |E| @,
Attributes Form Fill style |-Solid - | e
Joins Stroke color | |E| @,
Auxiliary Stroke width | 0.260000 @ 2] |milimeters v | €L

e
Grounded - Explore your world 87 Scionce Sﬁ

Foundation
Ireland For what's next



In Fill style change Solid to BDiagonal:

() Layer Properties - SAC_ITM_2019_12 | Symbology X
Q E Single symbol bt ‘
fi Information ~ [l Fil |¥|
a Il simple fill ==
& Source
‘ Symbalogy . |il ‘ 3 ‘
> 2750
N# 3D View Symbol layer type Simple fill - |
E I Fill color ‘E‘,
E Attributes Form Fil shyle I B soid e
Joins Stroke color No Brush @,
Harizontal
stroke width | | | | | vertical (=R
Stroke style GIOS E,
Join style SN FDiagonal e-v
m Diagonal X
Offset B pense 1
B Dense 2
m Dense 3
ﬁ Dependencies
Legend Dense 7
v Enable layer €=, Draw effects
P Layer Rendering
| Style 'l oK | ‘ Cancel | ‘ Apply ‘ | Help
Now change the Fill colour to red by clicking the downward arrow:
() Layer Properties - SAC_ITM_2019_12 | Symbology X
Q :- Single symbol hd |
"’i Information ~ 2 Fin |¥‘
a Simple fill o
@ Source
‘ Symbology |ﬁ‘ | 3 |
& 20 View
N 3D View Symbol layer type| Simple fill - |
iE ricios a
= 3
E Attributes Form Fil style Transparent I - | @,
L A Stroke width a ‘3‘ [ milimeters | 4=
Stroke style A | e,
® Actions ‘ HEX #e31alc
® Disoioy Join style RGB 227,26,28,255 =
A=ss) HSV 350,226,227
& Rendering Offset
Variables
a. Metadata
m Dependen
Recent colors
Standard colors
Copy Color
Paste Color
Pick Color
‘ Style Choose Color... | ‘ Cancel ‘ | Apply | Help
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Also change the Stroke colour to red, select Apply and Ok:

() Layer Properties - SAC_ITM_2019_12 | Symbology

Q = single symbol

fi Information

{Q- Source

Q’ Symbology

- Fill
Simple fill

€ Labels
'I Diagrams
\“ 3D View Symbol layer type| Simple fill M
e o N | .
E Bt i Fill style /- BDiagonal MIKES
Joins R | <.
L Auxiliary Stroke width | 0.260000 @ 3| | Milimeters v | €
~ Storage Stroke style Solid Line MK EE
{G Actions
y Join style ) Bevel > | €
- Display -
o - ffset * DA ' Millimeters -
4 Rendering T v [0.000000 -
Variables
E Metadata
ﬁ Dependencies
Legend
& QGIS Server
ﬁ Digitizing
V| Enable layer @, Draw effects
P Layer Rendering
Stle ‘TN‘ Cancel ‘W| Help

You can see that the SACs in your Map Viewer have changed to diagonal red lined polygons:

(@ *Habitats - QGIS
Project Edit View Llayer Settings Plugins Vectar Raster Database

hoAREY OepLAPP
BEVARE L/ -

Browser BE
GRY®TO
7' Favorites
b Y Spatial Bookmarks
» [ Project Home
» [3] Home
y I
@ GeoPackage
/7 Spatialite
@ rostGls
P mssaL
@ Oracle
2 pB2
@ WMS/WMTS
» @ XYZTiles
& wcs

& ArcGisMapServer
&) ArcGisF eatureServer
3% GeoNode

Layers
« @V &> AL
V| © Centre-location
v [] sPA_ITM 2019_12
SAC ITM 2019 12 [

~ |V #* Google Road
- * Google satellite

Web Mesh Processing Help
BLNR &

= @ =

® 2 B

Roadfond

Dookn
Folea

cottiges

Docnagare

-E-e-REE¥ =0 T

=)
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SCHOOL

17. Now change the SPAs. Right-click the SPAs layer and select Properties. In the Properties window

select Symbology and click on Simple Fill. Change the Fill style to Vertical:

- Layer Properties - SPA_ITM_2019_12 | Symbolo X
~ Lay! P ! gy
Q. :— Single symbol -
G‘ Information ~ [ Fin @_]
a | B Simple fill
& Source
Symbology D '@‘
[ELEH
Diagrams
3D View Symbol layer type Simple fill v
Fields Fill color ~ @v
E Attributes Form FiTsye Bl soic ’=l
Mo Brush
Joins Stroke color o B ‘E‘v
Horizontal
= Cross
Stroke style Ev
{;@ Actions 27 BDiagonal
. Dicol Join style [ FDiagaonal E}v
Ispiay m Diagonal X
& Rendering Offset BB Dense 1
BB pence 2

Variables

a. Metadata

ﬁ Dependencies

Legend

Now change the Fill colour and Stroke colour to purple. You can click on the colour wheel and then click within

the triangle to get the shade of purple you want:
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SCHOOL
(2} Layer Properties - SPA_ITM_2019_12 | Symbalogy X
Q :- Single symbol -
1 Information ~ M Fin C{I}J
H Simple fill
ource
— . =
Qa3
[ELEH
Diagrams
3D View Symbeol layer type Simple fill -
Fields
€ Fill color B €
E Attributes Form Fill syle Transparent Fill -~ &
T
Joins Stroke color - E,,
=% Auxiliary Stroke width @ 3| Milimeters - ‘E',
- Storage
Stroke style w7 é,
(G’ Actions
) Join style > €
, Display -
’;' Rendering Offset = Millimeters -
Variables
ak Metadata
ﬁ Dependencies
Recent colors
&8 qGls Server Standard colors
ﬂ Digitizing . . . . .
V| Enable layel Copy Colar
Paste Color
» Layer Rel Pick Color
Style ~ Choose Color... | Cancel Apply Help

Change the Stroke colour to purple as well. Now we have matched the style we saw for the Tullamore River
Project. However, if you think your map would look better with different colours or patterns, change them to
whatever you think looks best.

18. Now we need to add the labels for the Current Viewing Point, the Centre Location and the Proposed
Viewing Platform locations. Let's update the Proposed Viewing Platform CSV file in Excel to include
the two other points, then all the sites will be stored in one file and we can add their labels in QGIS.

19. Open the Proposed Viewing Platform CSV file in Excel and save a new
version, call it Sites.

20. Set up your table like below. We already have the coordinates for the Cliffs of Moher Centre from the
previous exercise, add this information into the cells on the table:

Adding multiple points

A ! B | C 1 D |
1 |id Label Latitude Longitude
2 | 1 Proposed Viewing Platform = 52.981097 -9.429096
3 | 2 Cliffs of Moher Centre 52.972014 -9.426352
< 3 Current Viewing Point

e
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21. Now, open Google Maps on your Internet Browser to get the coordinates (in decimal degrees) for the
current Viewing Point location — it's north of the Pollboy Lookout:

Google Maps > Right Click location > Select Coordinates

Aillenasharragh

52.98528, -%3234
Directions from here
Directions to here
What's here?

Ball Search nearby

[Ga7g]
Print

Add a missing place

Add your business

Report a data problem

Measure distance &

T

Enter the coordinates into the Excel table. Your table should now look something like this, although bear in
mind that your coordinates may differ by a few metres.

A B C L
1 |Id Label Latitude Longitude
2 1 Proposed 52.9811 -9.42391
3 2 Cliffs of M 52.97201 -9.42635
4 3 Current Vi 52.98523 -9.42955

22. Make sure you've saved the Sites file (CSV file) in your Data folder and close Excel.
23. Open QGIS and add the table to your workspace.

Layer > Add Layer > Add Delimited Text Layer > Select the Sites CSV file

Q

Choose a Delimited Text File to Open
« . 5> ThisPC » Desktop > QGIS-FS » Data »

Organize « Mew folder

2} MName Date modified
# Quick access

GSI_Bedrock_500k

I Deskiop GS|_Groundwater_Bedrock_Aquifers

& Downloads SAC_ITM_2019.12.0

[5] Documents SPA_ITM_2019_12.0

&=/ Pictures B Propesed-Viewing-Platform
Camtasia-vids 031] Sites

—~L
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24. You will see that it adds three points at your site locations to your workspace. You can remove the old
layers for the Platform Location and the Centre (right click > remove layer).
25. Now we will add labels to the site locations.

Right click > Properties > Labels > Single Labels:

(-) Layer Properties - Centre-location | Labels X

No labels

Information

Rule-based labeling
» Source Cg Blocking

" Symbology

-
1

Diagrams

N7 3D View

i rieios

E Attributes Form

Click the down arrow of Value and choose 'Label' (this is the label we included when creating the CSV):

| () Layer Properties - Sites | Labels X

| | =1 Single labels

a
- = 1
'(i Information Value |113 d > | | €|

Source

1.2 |atitude

* Symbology

1.2 |ongitude

Labels

e
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26. Most labels look best when they have a white buffer around the letters. To do this click Buffer and
tick the box 'Draw text buffer":

() Layer Properties - Centre-location | Labels

Q

rf Informatio
‘:\_'\\ Source
% symbology
Labels

Diagrams

3D View

B rieios

E Attributes

Joins

L Auxiliary
W Storage

{;@ Actions

. Display
r

& Rendering

Variables

Gt Single labels

Value |abe Feature Ma

v Text Sample

Lorem Ipsum
Lorem Ipsum #||172778 ~ ||y
abe Text Buffer
v L\x[))raw text buffer @,
- -
. Background Size 1.0000
J Shadow Millimeters v
%° Callouts
% Placement ok
v Rendering Color buffer's fill
Opacity 1| 100.0 % =
Pen join style n Round -
Blend mode | Normal A

Draw effects

L1

o ol

@@ @

You can also change the font style, colour and size by clicking Text and changing the properties:

Q Layer Properties - Sites | Labels

Q,

(i Information

a\&\ Source
Symbology

@B Labels

Diagrams

Auxiliary
Storage

® Actions
_’ Display

"" Rendering

Variables

l Metadata

m Dependencies

Legend

1 Single labels
Value | abe Label
w Text Sample

Lorem Ipsum

| o] | 1:18557 |~ || &%

41

|Lorem Ipsum
] [ A
“*8 Formatting  [Font | Lucda Sans Typewriter - &
488 Buffer
@ Background Pyl |Regular | &
o/ Shadow u € 5| € IE=RFiE=!
‘,’f” Callouts E. e a @
1 |
‘:’ Placement
,“ Rendering Points = ﬁ
coor | (N - <L
(Opacity 100.0 % B =E
1. All settings al~| 2
e - Lok J[ ool [ soy J[ heb

It's your map — choose whatever styles, colour and size that you like best. Click Ok when you're happy with

your choices.
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27. Your map is ready to be added to Print Layout.

Project > New Print Layout. Name this Print Layout 'Habitat Map':

Q Create print layout Title

Enter a unique print layout title

(a title will be automatically generated if left empty)

X

[Habitat Map

| OK | Cancel

"

1. Add a map using the Add Map icon, |E3 Remember to drag your mouse and draw a rectangle for

the map.

4
Bear in mind the Interactively Edit Map Extent icon Pt to drag and zoom in and out of your map. To stop

a
panning within the map, click the Select Icon, % so that the map behaves like an object. You can also

replicate what is in your Map Viewer by selecting the Set Map Extent to Match Main Canvas Extent icon, © :

. Don't forget that you can also set the scale:

Layout Item Properties Guides
Item Properties

Map 1

P EBRER PR

¥ Main Properties

Scale [}‘ | 100000]
Map rotation | 0.00 ©

CRS LIse project CRS

v | Draw map canvas items

| &

==
2. Next, add a scale bar using theicon, & . Drag your mouse and

canvas now has a map and scale bar, looking something like this:

draw a box for the scale bar. Your

L Wduﬂrmvr:% //%
Doolin RZ78 @ %
J’ ’ Tl‘ . Kilfenora ‘;
Miscrrr ) %é%@ﬁ@:\mm
L&hineh
s}
Grounded - Explore your world 95

U
7\
Science S I
Foundation

Ireland For what's next



UscrooL

3. We need to explain to the reader what the lined polygon areas (SACs and SPAs) in the map represent.

E—
To do this we add a legend. Select the Add Legend tool, ®-E2:

Q *Habitat Map
Layout Edit View

-

T

‘ -100
T R T

.

=

o
T

-20 ‘

B2 E

&
o, 0

2

=

o
=4

&

Iltems Add lter

B [

LB HY 2@

‘—sn e
1

;-hdds a new Legend to the Iayouti

[#]

Drag your mouse and draw a box for the legend.

4. With the legend selected, click the Item Properties tab and untick the 'Auto update' box. This allows

you to change what it shown in the legend.

Select the elements you want to remove from the legend and click the minus symbol. Only leave the SPA and

SAC layers in the legend:
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Rave|

Kilfencra

o Cenfre-lo@tion
(111 SPA_TTM_2019_12
177} GAC_ITM_2019_12
Google Road

| O

Google Satellite

m

Layout Item Properties Guides

Item Properties
Legend
Wrap text on

Arrangement | 5= Symbols on Left -

v Resize to fit contents

w Legend Items

Auto update Update All

@ Centre-location

[]] sPA_ITM_2019_12

SAC_ITM_2019_12
* = Google Road

== Google Satellite |

v|[a|d@)® (=]

Only show items inside linked map

Only show items inside current atlas feature

Within the Legend Items panel double click the SPA and SAC layers to rename them as Special Area of
Conservation (SAC) and Special Protected Area (SPA):

- = Layout = IltemProperties | Guides
@ Legend ltern Properties X Itern Properties
Legend

PO Ttem text

|special Protected Area (5P4) | ¥ Legend Items

> ok Cancel
d Vi = 2 Update Al
of \MoherCentre
[Rag1}

Scroll down within the Item Properties tab to turn on the frame on for the legend:

Layout Item Properties Guides

Item Properties [ELE]
Legend

Only show items inside linked map

Only show items inside current atlas feature

Fonts and Text Formatting
Columns

Symbol

WMS LegendGraphic
Spacing

Position and Size

Rotation

v
-

Thickness | 0.30 ¥||mm ¥

v v v v v v h 4

Join style | B Mmiter -
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5. Add a North arrow using the North Arrow tool (like in Exercise 2).

5,

You can make the font bigger by clicking 'Font' from the Item Properties Tab under Appearance:

6. Add the title 'Habitat Mapping for Public Consultation' using the Add Label icon,

(X Text Format X
Font Font style Layout | Item Properties | Guid
MS Shell Dlg | Reqular 14 ayou ] e Hides
MS Reference Specialty “| |Regular 9 - I‘[lsll’ndPropemes
M5 Sans Serif Bold 10
MS Serif 11 ¥ Main Properties
MS Shell Dig 2 - 12
4 4 - Habitat Mapping for Public Consultation Workshop
Effects Sample
Strikeout
Underline AaBbeZZ
Writing System
Any v Render as HTML
oK Cancel Insert an Expression...

v Appearance
Protected Areas (SPAs)

Areas of Conservation (SACS) -
Author: Fona Stay
s sora oz Font color O

Horizontal margin | 0.00 mm

4»

Vertical margin 0.00 mm

4

You can also change the font type, colour, add a frame or background.

7. Use the Label Tool, to add the author and date. Write your name and include today's date.

8. Putaframe around your map (like in Exercise 2 — click on map > item properties > tick frame).

9. There is a final, very important step that we must incorporate. It is important to give attribution to
work that is not your own. For maps, we do this by crediting where the data was sourced from.

Our map in this Exercise includes Google Roads as well as the SACs and SPAs, which are from the National
Parks and Wildlife Service. The layers themselves often contain helpful information regarding how to credit the
data source. We access this in QGIS by doing the following:

Right-click the layer in the Layer Panel > Properties > QGIS Server > Attribution

10. Do this now to the Google Maps layer:

() Layer Properties - Geogle Road | GGIS Server

w Description

o

G Information Short name |A name used to identify the layer. The short name is a text string used for machine-to-machine communicat...
J\_’\\ Source Title The title is for the benefit of humans to identify layer.

® s |

¥ Symbology Abstract
Bl Tansparency
| Keyword list |List of keywords separated by comma to help catalog searching.

&’ Rende

4 Rendenng Data Url A URL of the data presentation. Format =
l‘ Metadata

w Attribution
Legend )
Title |Map data ©2015 Google
59 615 Server Url  https:/fwaww.google.at/permissions/geoguidelines/attr-guide.html
Style - oK Cancel Apply Help
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11. Add the attribution 'Map data ©2015 Google' to your text box on the map:

Habitat Mapping for Public Consultation

Legend

[T Spedal Protected Area (SPA)
V7 Spedal Area of Conservation (SAC)

12. Check the SAC and SPA for attribution information in the same way.
13. Asyou can see, these layers don't include such information.
14. Search Google to try to find the information. Search for ' attributing SAC and SPA data':

Google attributing SAC and SPA data X

(=
Jo

Q Al [ Images E News @ Maps [ Videos  § More Settings  Tools

About 1,460,000 results (0.73 seconds)

WWW.Npws_ie » maps-and-data » designated-site-data -

Download Boundary Data | National Parks & Wildlife Service

Mational Parks and Wildlife Service designated area spatial data has been updated as of
December 2019. Changes ... The SAC and SPA shapefiles now contain a mixture of legacy Irish
... There have been some changes to the attribute fields.

You've visited this page 3 times. Last visit: 26/08/20

data.gov.ie » dataset » special-areas-of-conservation ~
Special Areas of Conservation - Datasets - data.gov.ie

Licensed under: Creative Commons Attribution 4 0| . Most Special Areas of Conservation
(SACs) are in the countryside, although a few sites reach into town or ...

15. Give attribution by including the following text (underneath the Google attribution in your text box):
'Contains Irish Public Sector Data (Natura Sites) licensed under a Creative Commons Attribution 4.0
International (CC BY 4.0) licence'.

O
Grounded - Explore your world 99 Sdgﬁ

Ireland For what's next



UscrooL

You may want to remove the textbox frame and background, and resize the text to size 7, to make it less

intrusive on your map. It's up to you:

Habitat Mapping for Public Consultation

[,
Lag*

A

Legend

[T Spedal Protected Area (SPA)
¥4 Spedal Area of Conservation (SAC)

Doolin

Bhagore

Viewing Foint

I
I-[r.upusr'rl Vaewing Rlatfiorm

=11 ffs of Moher Centre

f=3 L)
SCannor
D 5
LEakir

A
kKinch

=Ty

Ba78

Kilshanny

R487

Date: 20/01/2021
Author FS

Map cofz (02005 Google

NPNS cafz lconmed under 2 D‘s:h\em\i

Affribution 4.0 Infemafional {0C BY 4.0} loenoe:

16. All you have to do now is export your map as a PDF. Layout > Export as PDF. You can call it Habitat

Map. Always then open the file to make sure there are no errors
17. Well done! You have accommodated all the requests of the task

in the PDF production process.
to produce a map which shows the

SPAs and SACs near the Cliffs of Moher. You also edited symbology, added a CSV file with multiple

points, created a legend and attributed open source data.

Congratulations! You have completed all of the mapping exercises and learned the basics of QGIS. Review all
the skills that you have now acquired listed on the Goals Sheet in Appendix A. You are now ready to use these
skills to complete a project in your locality (see Section 2) and gain your QGIS School Certificate (see

application form in Appendix C).

There is no limit to how much exploring of your world you can do with QGIS, the more you use it the more you

will develop. You don't have to be an expert in order to be able to create
even, just to explore your world.
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2. PROJECTS

Projects are effective in grounding students with the principles of GIS, as well as for investigating issues both
relevant to their locality and in a broader context.

To be awarded the QGIS School certificate (see Appendix B) you must undertake a group project which
involves the use of QGIS.

The group work can revolve around group discussion with optional aspects of collaboration, or the project
might be fully group orientated.

Each student must submit an individual form of assessment (poster or video — see Section 3).

The following timetable is suggested, but your class is free to modify the timeframe for project completion:
Week 1: Choose and discuss Project with group, strategize — assign roles, background mapping;

Week 2: Fieldwork and/or digital mapping, begin poster template or video script;

Week 3: Create map; draft poster or video;

Week 4: Poster/video submission and/or presentation to teacher, class discussion and feedback.

PROJECT OBJECTIVES:

e Students work together, sharing responsibilities and carrying out of tasks to agreed deadlines.
e Student’s appropriation of a local issue from a geographical perspective.

e Usage of GIS as a technical tool to investigate the socio-spatial issue.

e  Presentation of the issue through poster/video delivery which includes a map(s).

e Potential to enter competitions such as The Young Environmentalist, Eco UNESCO

e
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PROJECT EXAMPLES

This section includes project examples that you may replicate in your locality. However your group may modify
these examples or come up with your own project idea. The only requirement is that your project uses QGIS in
some aspect.

The section is divided into three categories — those suited to any locality, and those better suited to urban or
rural environments. One project example of each category is outlined with broad steps, followed by some
project idea suggestions.

PROJECTS SUITABLE FOR ANY ENVIRONMENT

PROJECT EXAMPLE: FUN RUN

Objective: Using QGIS as a planning and presentation tool.

TASK: Imagine you are holding a local fundraiser 'Fun Run' for a charity of your choice. Use QGIS to plan your
route and create a map for inclusion on posters or in a promotional video. Include the following criteria:

e 5kminlength

e Labelled Start/Finish points

e  Start/Finish points have adequate car parking nearby, highlighted on map
e Safety: family friendly footpaths/roads (low traffic, no cliff edges)

o Accessible (wheelchair friendly: no uneven terrain, steps or narrow paths)

Broad Steps:

Add base mapping e.g. OSM TopoMap (useful for checking slopes)
Create a 5km polyline bearing in mind the criteria.

Create a point file and include the start and finish points.

Create a polygon or point file to highlight the location of the car parking.

vk wh e

If possible do a site check and take photographs to add to your poster or video presentation.

OTHER PROJECT IDEAS:

e Wildflower Planting: Identify good locations for planting wildflowers and present it on a map.
Calculate area and estimate a fundraising goal to purchase seeds.

e Top 10 things to do in your area/county/Ireland: map of attractions e.g. science, sport, history, art,
'fun', outdoor activity, natural beauty.

e Commuting: Map everyone's commute to school. See who walks, car, bus, cycles; calculate the
longest distance; highlight any commonly congested areas.

e Recycling: Create a map showing the location and type of the different recycling facilities in your area.
Are the recycling facilities adequate and at appropriate places? Think of travel time and accessibility.

O
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PROJECTS FOR URBAN AREAS

PROJECT EXAMPLE: LOCAL TOWN ACCESSIBILITY

Objective: Use QGIS to produce a useful map for tourists with accessibility requirements.

TASK: Your local tourist office wants to include a map showing what is available for tourists with accessibility

requirements.

Broad Steps:

Conduct fieldwork to investigate your local area's accessibility features (e.g. ramps, toilets, doors,
handrails) for different amenities: look at eateries (pub, restaurant, café)), things to do (leisure
centres, museums, amusement parks, etc.), public toilets, parks.

Add point data in QGIS for locations that are accessible

Add polygons for areas in parks that are accessible

Add point data for 'Things to Do'

e Comment on no. available in general vs no. available for people with impairments (blind, deaf,
physical or mental disability). Is it adequate?
e  What suggestions could be made to make your town more suitable for everyone?

OTHER PROJECT IDEAS:

Personal Map: Create your unique map of the town: favourite café, friend or relations' houses,
favourite thing to do, where you go to school, your gym/pool/running track, etc.

Community Garden Location: identify suitable locations in order to seek Council permission to create
a community garden.

Create a historical walk map for your town or city. Highlight attractions and comment whether they
are accessible to all. Include the distance of the walk and the time estimate to complete it.

O
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PROJECTS FOR RURAL OR COASTAL AREAS

PROJECT EXAMPLE: GEOTOURISM

Objective: Demonstrating aspects involved in allowing us to enjoy activities in our locality and how to use GIS

to help inform us in protecting against threats.

Task: Create a map showing the location of a nature-based tourist attraction in your locality, to be used on

tourism brochures. Also create maps to show the interdependence of this attraction on other local factors

(geology, drainage (hydrology), soil type, road access, etc.). These maps will help inform measures to be

considered to protect the activity against potential threats in the future.

Broad Steps:

Create a map showing the location of a nature-based activity in your locality that is also a tourist
attraction e.g. horse-riding, surfing, cycling, natural attraction (e.g. Malin Head).

Highlight the location on your map by doing one or all of the following options:

a) Add a point (e.g. a point labelled 'surfing' or at an attraction e.g. 'Giant's Causeway')

b) Draw a polygon (e.g. draw an area labelled 'Park')

c) Draw aline (e.g. draw a route labelled 'mountain bike track')

Think about all the environmental factors that make your chosen activity possible and create maps of
these relevant factors (landscape (geology), drainage (hydrology), etc.). Comment on threats to your
activity (pollution, erosion, development, etc.). Soil data can be downloaded from:
http://gis.teagasc.ie/soils/downloads.php.

If possible do a site check and take photographs to add to your poster or video presentation.

OTHER PROJECT IDEAS:

Tree identification: Record the different types of trees in the locality and present their locations on a
map.

Cycling: Map your favourite cycle route. Highlight any dangerous areas (bends, uneven road surface,
steep edges, busy traffic). Provide the distance travelled and a time estimate to complete the route.

O
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3. ASSESSMENT

The assessment comprises summarising your group project in a poster or short video (5-10 mins). The
following are a few key features to include:

e Title of Project

e Collaborators (Group Name/logo)

e Author (You)

e School crest

e Introduction (can include Background and Obijectives)
e Methodology

e Results

e  Conclusion (may include Recommendations)

e Acknowledgements, if appropriate

e Attribution to data sources.

POSTER

We recommend designing your poster in PowerPoint which is very easy to use and produces good quality
results. Guidelines for poster presentation and poster examples can be found in Appendix F. You may choose
Portrait or Landscape orientation and can choose whatever size you like:

A1:(84.1 cm x 59.4 cm) A2:(59.4 cm x 42.0 cm) A3: (42.0 cm x 29.7 cm)

Tip: To set the document size in PowerPoint, choose File > Page Layout >Slide Size > Custom > [insert size].

. .

Size ~ Background

Variants Customize
Slide Size ? *
Slides sized for: Orientation
207x420 mm) Slides
Width: () Portrait
35.56m [+ @ Landscape
Height: _
2667 am = Motes, Handouts & Cutline
Mumber slides from: @ Portrait
1 - O Landscape
Cancel

Hint: To print effectively, images should be high resolution (150-300 dpi).

VIDEO

Video submissions may involve you simply explaining your project and pointing at your maps, or you can
incorporate props, use of PowerPoint, act, etc. You could submit a video in cartoon format, as long as you
incorporate the points above. For some inspiration check out some examples of university student film
productions about the History of Life:
https://www.youtube.com/channel/UCNgZkvOCmDcdCpAuWvnJArQ/playlists.
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4. CONCLUSION

This course taught digital mapping through problem-solving exercises, with consideration of the United
Nations 2030 Agenda Sustainable Development Goals. You have developed critical thinking skills and can
navigate QGIS software to interrogate data and produce maps. The skills acquired through completing this
course are summarised in Appendix A. You are now better placed for many careers, as well as for general
citizen involvement with the world around you.

QGIS SCHOOL CERTIFICATE

Upon completion of the classroom course and submission of one project, the student may be awarded a QGIS
School Certificate, an example is shown in Appendix B.

Each student must submit an application form (Appendix C) to QGISschool@gmail.com, with evidence of their

QGIS project by choosing a form of assessment:

e  Submit an A4 poster (visual or text based)
e Submit a short 5-10 minute video

Students may submit both forms of assessment.

FEEDBACK

To provide feedback on this course please submit the Student Evaluation sheet in Appendix H to
QGISschool@gmail.com.

If you have any queries you can contact QGISschool@gmail.com or use the contact information at

http://www.nuigalway.ie/eos/.

We hope you enjoyed completing this course as much as we enjoyed creating it.
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SCHOOL
Goals Sheet
Tick each Exercise off as you go and see your progress!
Lesson Exercise QEIS Skills Acquired lete
1 Intro to Maps 1A Intro to QEIS Data management
and QEI5
QELS workspace intro
1B Your First QGIS Use of a Plug-In
Map
Create a shapefile
Add a label
Export a map
2 Map Layout Intro fo the Print  Print Layout
Com| r
pose Add text
Add scale bar
Add north arrow
Export as PDF
3 Q&IS for Using QEIS fo Drawing polygons
Management Decisions Measure Area
Calculating area
Coordinate reference systems
Changing opacity of layers
4 QEIS for Investigating Downloading open source data
Environmental Geology and

5 Mapping to Protect
Our Environment

5 QGI5 and Habitat

Mapping

Categorising symbology
Loading a style

Using Identify Features Tool
Add point using C5V file
Exporting shapefile from C5V
Measure distance

Create a polyline

Caleulating distance of polyline
Create a buffer

Editing symbology

Adding multiple points

Add a legend

efefelefelefelefelele Yo Yol e o] e el efe] o o) e el e el e o] |
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APPENDIX B: COURSE CERTIFICATE
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APPENDIX C: CERTIFICATE APPLICATION

Email this form to ggisschool@gmail.com; attach your project poster or video

Y1 QS!S
'scHooL

CERTIFICATE APPLICATION FORM

STUDENT NAME:

PROJECT TITLE:

CERTIFICATE: Grounded: Explore your world
DATE OF APPLICATION:

TEACHER:

TEACHER EMAIL:

SCHOOL:

Brief Project Description (max 200 words):

INFORMATION RELEASE AGREEMENT

QGIS School, in partnership with iCRAG and NUIG, may want to publish your project on our websites or other
marketing material. Sign the information release agreement if you give permission for this use of your work.
This is not a requirement for you to recieve your QGIS School Certificate. You may leave this section blank.

I, (Student's Name), hereby grant QGIS School the legal copyright to the

following work: (Project Title).

QGIS School may therefore use the images and infrormation to their discretion, and may reproduce in any

size or quantity the work stated above.

Student Signature:

Guardian's Signature: Date:

www.nuigalway.ie/eos/

)
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APPENDIX D: RESOURCES

Dedicated Webpage: All the Grounded course material can be accessed at the National University of Ireland
Galway Earth and Ocean Sciences website: http://www.nuigalway.ie/eos/grounded/.

Dedicated YouTube Playlist: The exercises covered in the Grounded manual are available as video tutorials
at the You Tube channel 'QGIS School', accessed at https://cutt.ly/9jUZ7bE.

Data download resources:

Geological Survey of Ireland: https://www.gsi.ie/en-ie/data-and-maps/Pages/default.aspx.

Soils data download: http://gis.teagasc.ie/soils/downloads.php.

National Parks and Wildlife Service: www.npws.ie, for research and can download SAC/SPA data.

Ireland's open data portal: https://data.gov.ie/.

General suggested resources:

Environmental Protection Agency (EPA): www.epa.ie. Information on waterways, bathing waters, air
quality, soil, River Basin Districts, etc. Map viewer is accessible here: https://gis.epa.ie/EPAMaps/.

Irish Centre for Research in Applied Geosciences (iCRAG): https://www.icrag-centre.org/education-and-
public-engagement/education/secondlevel/. iCRAG researchers can visit your school to deliver a Smart
Futures talk, please contact elspeth.wallace@icrag-centre.org.

Environmental Information: www.enfo.ie. Ireland's public web site on environmental issues; will organise
guest speakers and visits to the centre. They have a lending library of media resources for teachers - posters
and leaflets on a variety of issues.

Eco Unesco: www.ecounesco.ie. Competition for the Young environmentalist. They will visit your school
and give workshops/guest speakers, etc.

Cultivate (National NGO and Civil Society Organisation): www.cultivate.ie. Organise events and lectures on
sustainable living and green issues.

Community Gardens: http://www.indymedia.ie/openwire?search text=community+gardens.

Growing Vegetables: http://www.irishseedsavers.ie/irish-school-garden.php. Irish Seed Savers work in
tandem with secondary school groups to develop projects focused on biodiversity, food security, soil and
fertility or climate action. Focus on activity-based learning, project work, research with field trips.

Identifying Trees: http://www.treecouncil.ie/. Register your school for free trees for national tree week, get
facts and identification guides for trees, etc.

e
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APPENDIX E: INSTALLING QGIS

For the most up-to-date installation instructions, refer to the QGIS website: https://agis.org/en/site/. The

following steps are for installation using Windows.
Steps:
1. Check whether your computer system is 32 or 64 bit: Start menu > Settings > System

Click About in the left hand panel and read the System Type:

@ Home About
Find a setting fe! | Your PC is monitored and protected.
G @ Virus & Threat Protection

© Firewall & Network Protection
D s (] App & browser control
OCUS assis
A Account protection

@ Power &sleep @ Device security

3 Battery See details in Windows Security

= Storage

(@ Tablet mods Device specifications

[=H Multitasking LATITUDE 5500
Device name NUIG-69RNY33

&1 Projecting to this PC Processor Intel(R) Core(TM) i7-8665U CPU @ 1.90GHz 2.11 GHz
Installed RAM 32.0 GB (31.8 GB usable)

2% Shared experiences Device ID D3D380C8-6A16-4D8F-A340-C3C51AD57251
Product ID 00329-10181-47483-AA803

& Clipboard System type 64-hit operating system, x64-based processor

Pen and touch ~ No pen or touch input is available for this display
5 Remote Desktop

| Rename this PC
I|® About N

In the example above the system is 64 bit, so this requires installing the 64 bit QGIS.

2. Go to https://qgis.org/en/site/forusers/download.html and choose the Long Term Release
Standalone Installer (either the 32 or 64 bit according to your system):

Long term release repository (most stable):

i @\ QGIS Standalone Installer Version 3.10 (64 bit)

sha256

& @\ QGIS Standalone Installer Version 3.10 (32 bit)

sha256

3. Save the file to your computer (download folder).
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SCHOOL
¥ | = | Downloads
Home Share View
« v« 4 ¥ > ThisPC > Downloads >
w
Name Date modified Type Size

3 Quick access

~ Yesterday (3
[ Desktop y G)
A& Downlnads 2 QGIS-05Geo4W-3.10.9-1-Setup-x86_64 25/08/2020 1801 Application 393,364 KB

4. Onceit's finished downloading, open the file by double clicking it. If it asks 'Do you want this app to
make changes to this device?' click yes.

5. Complete the QGIS installation wizard which will include steps like the following:

(3} QGIS 2.10.9 A Corufia’ Setup = X

Welcome to the QGIS 3.10.9°'A
Coruna' Setup Wizard

This wizard will guide you through the installation of QGIS
3.10.9 A Corufia'.

l Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update

relevant system files without having to reboot your

computer.
Click Next to continue.
A Coruna
Next > Cancel
Note, the long term release version in 2020 was called 'A Corufia'. Your version may have a different
name.
e Inthe Licence Agreement dialog select 'l agree'
(3} QGIS 3.10.9 A Corufia’ Setup - pas
License Agreement
Please review the license terms before installing QGIS 3.10.9 'A Corufia’. 0\

Press Page Down to see the rest of the agresment.,

| icense overview:

1. QGIS

2. The NetCDF library and commands for reading and writing NetCDF format
3. SZIP compression library

4, ECW Raster Plugin for GDAL

5. Orade Instant Client

6. MrSID Raster Plugin for GDAL

7. The HDF5 library for reading and writing HDF5 format

(8, The HDF4 library for reading and writing HDF4 format

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install QGIS 3.10.9 'A Corufia'.

<o G

e Inthe Choose Install Location dialog do nothing (i.e. keep default destination folder as it is) and
click 'Next':
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Q QGIS 3109 "A Corufia’ Setup -

Choose Install Location
Choose the folder in which to install QGIS 3.10.9 'A Corufia'.

2D

Setup will install QGIS 3.10.9 'A Corufia'in the following folder. To install in a different folder,
dick Browse and select another folder. Click Next to continue.

Destination Folder

Space required: 1.8GB
Space available: 410. 1GB

Mullsoft Install System v2.50

< Back Next > Cancel

e In the Choose Components dialog do nothing and select Install:

Q QGIS 3,109 "A Coruna’ Setup - x
Choose Components
Choose which features of QGIS 3.10.9 'A Corufia’ you want to install. O\

Check the components you want to install and uncheck the components you don't want to
install. Click Install to start the installation.

Select components to install:
] North Carolina Data Set
[] South Dakota (Spearfish)
[[] Alaska Data Set

Space required: 1.8GB

Mullsoft Install System v2.50

e If any other steps appear, keep the options as default and click Next until you get to Finish:

@ QGIS 3.10.9 ‘A Corufia’ Setup —

Completing the QGIS 3.109 A
Corufia’ Setup Wizard

QGIS 3.10.9 'A Corufia’ has been installed on your computer.

‘ Click Finish to dose this wizard.

310

A Coruna

< Back Cancel

6. The program folder can now be found on your computer. You will only be using the QGIS Desktop
Program (version 3.10.9 in example below). Click this and ignore the other options:

e
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OSGeo4W Shell

QGIS Desktop 3.10.9

QGIS Desktop 3.10.9 with GRASS 7...

UscrooL

OneDrive

Explore

e

Microsoft Edge

Qt Designer with QGIS 3.10.9 custo...

SAGA GIS (2.3.2)

L rype here to search

7. The Program will start to open:

0 Welcome to QGIS 3.10.9-A Corufia
-~

Check out the change log for all the new stuff.

S

Microsoft Store

long term release

XGIS 310

A Corunha

e The Program is ready to use when you see the following window:

(2 Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
3 @ P RD Q ~
DEARRY OeLppaP RLUBHLOZ
LAY AN

Browser o8
gRrRY®*O
Favorites

» " Spatial Bookmarks
» [3] Home
»
» [IDA

@ GeoPackage

/ spatialite

@ rostals

P mssaL

@ Oracle

@B 082

& WMS/WMTS

!‘ @&
News
S|
?%;:\\\ (T
Project Templates

New Empty Project

EPSG:4326 - WGS 84

@ XVZ Tiles

@ wcs

@ Wrs

© ows

@ ArcGisMapServer
&) ArcGisFeatureServer

3 GeoNode
Layers o™
v 3eY 320

Type t0 locate (Ctri+K) Ready

#¥Tm-e) M-

@ 2 B

Crowdfunding campaign: Point cloud data support in QGIS

Coordinate

sl 77064 ~ | @ Magner 100%

With the recent advancements in LIDAR survey technology and photogrammetry there has been a growing demand for capturing and storing point cloud data. With this crowdfunding campaign, Lutra

< Rotation |0.0°

+ V/Render @ epscins @

Well done. You have successfully installed QGIS.
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APPENDIX F: POSTER GUIDELINES

You have a lot of room to be creative when making a poster and it is encouraged that you create a poster
whatever way you think is best for showcasing your Project. Nonetheless, there are some general rules to
follow to ensure that posters are as effective as possible.

Simple is good
Make important information stand out
Line things up

Ll S

Don't make it crowded

Banner / Title Section: This is the section at the top which includes the title of the poster, the author(s), and
the authors' affiliations (group the author is associated with). The title should be the largest text in the poster,
and the author names should be the next largest. The title should be large enough for someone to read from
several feet away. On a standard size print poster, this is somewhere between 96-120 pt.

Your affiliation will be the Group Name that you were part of as well as your school's name. Many researchers
also put the logo of their affiliation in the banner. You may want to create a team logo!

Alignment: Always bear alignment in mind when putting together your headings, columns, text and graphics.
Sections that aren't aligned can appear sloppy. For example, aligning each paragraph to the left edge of a
column will drastically improve the professional look of your poster.

Balance and Spacing: Include a margin of about 10mm along all edges of the poster. This is neater than letting
things overhang/be cut off, but also accommodates for printer 'bleed'.

Distribute the content and images in the poster so that it looks balanced e.g. you may space out your graphics
evenly, or you might opt to keep text to one section and graphics to another.

White or 'Empty' Space: Be sure to include some white or empty space. Too much content is difficult for
viewers to read the poster — 'can't see the wood for the trees'. The aim is to produce an uncluttered look
which is aesthetically pleasing.

Fonts: Pick fonts that are readable and don't distract from the content of your poster. Don't choose script-type
fonts as they are difficult to read, e.g. Bluckaditer 7 Some popular fonts include: Helvetica, Calibri and Arial.

Many people use one font for the headings and another for the body text, but one font for everything is fine.
Be consistent with your choice.

Headings: Divide the poster into parts with major headings for each section. Make the headings distinct and
consistent so that the viewer can easily see the structure of the content. You may also choose to add colour to
a heading level to set it apart.

Images: Images, graphics and photographs are generally a very welcome addition to any poster. However,
resolution is paramount. Avoid low quality downloads. Low resolution images will appear pixelated when
printed at larger scales. Zoom into your poster at 100% during design to check the resolution as this shows the
approximate print quality of your image. To ensure the highest resolution do not copy and paste directly onto
your poster. Instead, use the Insert > Pictures option.

0
Grounded - Explore your world 115 ’ Sfl

Science
Foundation
Ireland For what's next



UscrooL

POSTER EXAMPLES

Note: The poster content (text) is not intended to be readable at this print size, it is the overall layout and

design that we are critiquing here.

POOR DESIGN:

The following posters are messy looking. The arrows are confusing in both. The headings do not stand out. The
blue font is hard to read in the first poster and the different font sizes is overwhelming in the second poster.

Overall the effect of both posters is disorganised and unappealing.

25022007 « o g

CUSTOME
ERIEN g p

With Measurable ROI

How Are Just Eat, New Look, Orange & Santander Delivering
Exceptional Customer Experiences & ROI?

Create Insight-Led, Customer-Centric Journeys Across The Multi-Channel Mix, Engage
Customers & Win Staff Buy-In For Exceptional Customer Experiences With
Measurable ROI

One-Day Conference & Netwarking Event, 21st February 2017, One America Square, Central London. Download
The Brochure Here, Group Discounts Availablel Send 4 For The Price Of 3,

Benefit From 20 Senior Cross-Sector Experiences To
Restrategise Your Customers’ Experiences

H. ¥ o M5 How [l

Sarah Soral Head of gt Mascarerens Hesd  Louse Moghacam Jan Recrars
Customer Bxperance e Gt Heaaor Clpmesevis | [Rsgor sighss & Panning  Mead of insighe
Barclaycard 02 (Telefonica UK)  New Look daa (Dublin Airport)  Just Eat

B@ B ! I@ ﬂHSBCw NEW

Exceptional Customer Experiences
1 Day, 22 Speakers

) bowyeond 0, downc: @oz= Il I HSHC @ EEIESE Mewns UK POk usmowes - Soworwans G [N (@) ¢ guondion PEKIER = TalkTalk
HOME PROGRAMME CONTACT 212 SPEAKERS GET INVOLYED OUR PARTNERS YENUE TESTIMONIALS HELPDESK PRICES

DOWNLOAD

Conference Brochure

20 Brands Speaking

Saran Eborail
Bl Hevd of Cotomer
Eperence &) borclaycard

Barclaycard
E Masgarend;

s, Head
of Emamer Exparence

02 (Telefonica UK}

Lowise Moghaddam 3
- F of Copnorar Service VPE .-'«K
New Look LOO

Michael Alley, Jenny Lo, and Beviee Watford
Engineering Education, Virginia Tech
Introduction

The Boyer Commission Report has urged universities
to “make research-based learning the standard” for the
education of undergraduates. Given how tight
engineering curricula are, how can such curricula
promote and foster undergraduate research?

a

One idea is to use the technical communication course,
which already incorporates library research. This
project assesses whether a research option of such a
course could promote undergraduate research.

Undergraduate Research Experiences
Summer 2005

Promoting and Fostering Undergraduate Research
Through a Research Option in a Technical Communication Course

Sites for Research Experiences

Bucknell

East Tennessee State University

Georgia Tech (2)

University of lllinis at Urbana.Champaign
L

Penn State

South Carolina

Vanderbilt

Virginia Tech (8)

Woods Hole Oceanographic Institution

Undergraduate Research Symposium
Fall 2004: 42 presenters

Preparing for Research (1-credit)

Spring 2005: 20 students Fall 2005

Results

Aspect Goal Outcome
Participants in 2004 undergraduate 25 42
research symposium (trigger for course)

Number of enrollees in course sequence 25 20
Percentage of enrollees from

underrepresented groups 40% 55%
Number of enrollees who obtained 20 18

summer research pnsltmns
*Two
These smda'lh will dwwmell ﬂmr intemships in the Fall course.

Undergraduate Research Symposium
Fall 2005

[Assessment of Learning of
Technical Communication
Lsarning by thass in plat course

wersus
Learning by these in standard
technic, course.

-
Documenting Research (2-credits)

Conclusions

The pilot course was a success at promoting
research among undergraduates, especially those
from underrepresented groups

a

The question to be answered is whether the
students in this pilot course learn technical
communication as well as students who take a
standard technical communication course

Sponsor: NSF Grant 0341171
Program Officer: Ken Gentili
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GOOD DESIGN:

The following posters are appealing. There is great use of graphics. The balance and spacing produces an
organised effect. The colour palette is complimentary. Overall they are professional and interesting looking.
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I , TRAIN THE
ILLINOIS :

INTRODUCTION

BRAIN:

An Efficacy Study on Brain Recovary After Injury

STUDY DESIGN

BASELINE &

FOLLOW-UP TRAINING

CONEUSSIVE AND MILD TRAUMATIC
BRAIN EHJURY SYMFTOMS

COGNITIVE TRAINING WITH BEAIN 1O

REFERINCES
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APPENDIX G: PEER ASSESSMENT

Fill in the sheet below for each student's poster or video presentation. You may want to do anonymous peer
assessment, in this case leave the Assessor's Name blank.

Project Peer Assessment Sheet

Student Name

Project Title

Assessor's Name
(Your name)

Assessment Statement Mark out of 10
(1 = strongly disagree,
10 = strongly agree)

The poster/video informed me about an issue

The poster/video was engaging

The poster/video was aesthetically pleasing or enjoyable to watch

The poster/video has produced new information regarding an issue

The poster/video changed my way of thinking about an issue

The poster/video made me interested about an issue

The poster/video impressed me with its level of professionalism

Total Peer Assessed Score

e
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APPENDIX H: STUDENT EVALUATION

The things | most enjoyed about this transition unit were....

The most interesting thing | learned was....

| think the course will be useful because...

The things | least enjoyed about this transition unit were...

The things | found most difficult were...

I would suggest the following changes to make it better...

Please email your completed form to ggisschool@gmail.com

Thank you for taking the time to evaluate the course!

)
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Contact:
QGISschool@gmail.com for further
information

or visit
http://www.nuigalway.ie/science-
engineering/school-of-natural-
sciences/disciplines/earth-ocean-
science/grounded/.

U scHool

Mapping for the future
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http://www.nuigalway.ie/science-engineering/school-of-natural-sciences/disciplines/earth-ocean-science/grounded/

	Overview
	Acknowledgements
	Data:


	Forward for the Student
	Requirements for the Course
	Forward

	Inclusivity Statement
	1. Classroom QGIS Course
	Introduction
	Sustainable Development Goals
	Resources

	Lesson 1: Intro to Maps and QGIS
	Learning Outcomes:
	Background
	Resources

	Hand drawn Maps Activity
	Exercise 1A: Intro to QGIS
	Exercise 1B: Your First QGIS Map

	Lesson 2: Map Layout
	Learning Outcomes:
	Background
	Exercise 2: Intro to the Print Composer

	Lesson 3: QGIS for Management Decisions
	Learning Outcomes:
	Background
	Resources

	Exercise 3: Using QGIS to Measure Area

	Lesson 4: QGIS for Environmental Description
	Learning Outcomes:
	Background
	Describing the natural environment:
	Overtourism
	Resources

	Exercise 4: Using QGIS to Investigate Geology and Hydrogeology

	Lesson 5: Mapping to Protect Our Environment
	Learning Outcomes:
	Background
	Open Data:
	Resources

	Exercise 5: QGIS and Habitat Mapping


	2. Projects
	Project Objectives:
	Project Examples
	Projects suitable for any environment
	Project Example: Fun Run
	Other Project Ideas:

	Projects for Urban Areas
	Project Example: Local Town Accessibility
	Other Project Ideas:

	Projects for Rural or Coastal Areas
	Project Example: Geotourism
	Other Project Ideas:



	3. Assessment
	Poster
	Video

	4. Conclusion
	QGIS School Certificate
	Feedback

	Appendix A: Goals Sheet
	Appendix B: Course Certificate
	Appendix C: Certificate Application
	Appendix D: Resources
	Appendix E: Installing QGIS
	Appendix F: Poster Guidelines
	Poster Examples
	Poor Design:
	Good Design:


	Appendix G: Peer Assessment
	Appendix H: Student Evaluation

